
University of South Florida University of South Florida 

Digital Commons @ University of Digital Commons @ University of 

South Florida South Florida 

Textbooks Collection Tampa Library 

2007 

Journalism 2.0: How to Survive and Thrive Journalism 2.0: How to Survive and Thrive 

Mark Briggs 
contact@journalism20.com 

Follow this and additional works at: https://digitalcommons.usf.edu/oa_textbooks 

 Part of the American Studies Commons, and the Journalism Studies Commons 

Recommended Citation Recommended Citation 
Briggs, Mark, "Journalism 2.0: How to Survive and Thrive" (2007). Textbooks Collection. 2. 
https://digitalcommons.usf.edu/oa_textbooks/2 

This Book is brought to you for free and open access by the Tampa Library at Digital Commons @ University of 
South Florida. It has been accepted for inclusion in Textbooks Collection by an authorized administrator of Digital 
Commons @ University of South Florida. For more information, please contact digitalcommons@usf.edu. 

https://digitalcommons.usf.edu/
https://digitalcommons.usf.edu/
https://digitalcommons.usf.edu/
https://digitalcommons.usf.edu/
https://digitalcommons.usf.edu/oa_textbooks
https://digitalcommons.usf.edu/tlib
https://digitalcommons.usf.edu/oa_textbooks?utm_source=digitalcommons.usf.edu%2Foa_textbooks%2F2&utm_medium=PDF&utm_campaign=PDFCoverPages
https://network.bepress.com/hgg/discipline/439?utm_source=digitalcommons.usf.edu%2Foa_textbooks%2F2&utm_medium=PDF&utm_campaign=PDFCoverPages
https://network.bepress.com/hgg/discipline/333?utm_source=digitalcommons.usf.edu%2Foa_textbooks%2F2&utm_medium=PDF&utm_campaign=PDFCoverPages
https://digitalcommons.usf.edu/oa_textbooks/2?utm_source=digitalcommons.usf.edu%2Foa_textbooks%2F2&utm_medium=PDF&utm_campaign=PDFCoverPages
mailto:digitalcommons@usf.edu




Journalism 2.0 is an initiative of
J-Lab: The Institute for Interactive Journalism, 
a center of the University of Maryland Philip Merrill College of Journalism, 
and of the Knight Citizen News Network, 
which is funded by the John S. and James L. Knight Foundation.

Jan Schaffer, Editor
Steve Fox, Michael Williams, Craig Stone, Contributing Editors

Design: Wendy Kelly, wlkdesign.com

©2007 Mark Briggs

This work is licensed under a Creative Commons 
Attribution-NonCommercial-NoDerivs 2.5 License.



MMaarrkk BBrriiggggss

Mark Briggs is a recovering sportswriter who discovered
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and a bachelor’s degree from Gonzaga University. He has also served as an
adjunct professor at Seattle University. 

He lives in Tacoma with his wife, son and daughter.  



Funded by the John S.  and James L.  Knight  Foundation



Journalism 2.0
How to Survive and Thrive

A digital literacy guide for the information age

Written by Mark Briggs
Foreword by Phil Meyer

Edited by Jan Schaffer

An initiative of J-Lab and the Knight Citizen News Network

 



“Can you send an
attachment with an
e-mail? Then you
have what it takes
to publish a blog
with pictures.”

— Mark Briggs
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Jan Schaffer and I first met in 2001, when the newspaper I was working for (the
Herald in Everett, Wash.) won a grant from the Pew Center for Civic Journalism to
attempt an interactive, clickable map for a series of stories about waterfront devel-
opment. Thanks to her support, the project was developed and became an instant
success. It won national journalism awards and was emulated by other news organi-
zations, but, most important, it helped steer the direction of waterfront develop-
ment in Everett, giving the community greater input into its local future.

Now, six years later, she is still making things happen for journalists and commu-
nities as director of J-Lab. While we were having dinner in Seattle in April of
2006, I mentioned the training series I had launched in the newsroom in Tacoma.
I remember her response: “You should write a book.” And so I did.

Thanks to her skillful editing, and the thoughtful input and former washington-
post.com editor Steve Fox, I have cobbled together what I hope is a useful guide
for working journalists who are ready to embrace the digital age. Much credit goes
to the keen editing of Associate Professor Michael I. Williams, of the University of
Maryland’s Merrill College of Journalism, and J-Lab’s Craig Stone.

My colleagues at The News Tribune also deserve thanks, for letting me do a little
“moonlighting” with this project, and for supplying the real-world experiences
that drove the content. Cheryl Dell, David Zeeck, Karen Peterson, Bill Hunter, Cole
Cosgrove, Laura Gentry, Jeff Hendrickson, Craig Sailor, Rick Arthur, Mike Sando,
and so many others have made this possible, and continue to help me help every-
one in the newsroom in this ongoing evolution.

Other smart and dedicated professionals were kind enough to offer their expertise
to the project, including Mindy McAdams, Kirsten Kendrick, Joanne Lisosky, Rob
Wells, Jessica Luppino, Marilyn Pittman, Ken Sands, Tom Wolfe, Howard Owens,
John Cook, Jonathan Dube, and C. Max Magee.

And none of this would be possible without the love and support of my wife, Lori,
and the patience of my children, Sam and Ellie, while I chipped away at this over
several months. 

-Mark Briggs
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By Phil Meyer

Most of the things that I needed to know for my Twentieth Century journalism
career I learned in high school, and they are still useful today: Touch typing,
writing a simple declarative sentence, respect for scientific method and the Bill
of Rights. My school was too small to offer a photography course, so I taught
myself out of a library book and by helping a teacher shoot group photos for the
yearbook with a pre-Anniversary Speed Graphic. 

Scientific method and the Bill of
Rights are, of course, eternal. The
technology of communication is
not. My self-taught darkroom
skills are obsolete today,
although touch typing and shoot-
ing pictures (knowing when to
push the button) are still impor-
tant. Meanwhile, the digital age
has brought forth a cornucopia of
new tools. Trying to teach jour-
nalism is frustrating when neither
faculty nor students can predict
which of the new technical tools
will be useful, what kind of spe-
cialists will be needed to use
them, and how those specialties
will be managed.

And yet, management skills
might be the key to the future.
As technology begets specializa-
tion, we will need skilled man-
agers to direct the output of all
those specialized tasks toward a
coherent whole. The old adage,
“A good reporter is good any-

Scholar, researcher and
teacher Philip Meyer is the
Knight Chair in Journalism in
the School of Journalism and
Mass Communication at the
University of North Carolina
at Chapel Hill. 

His 1973 book, “Precision Journalism,” was 
listed by Journalism Quarterly as one of 35 sig-
nificant books of the 20th Century on journalism
and mass communication. The fourth edition was
published in 2002. His most recent book is “The
Vanishing Newspaper: Saving Journalism in the
Information Age,” published in 2004.

In 1967, Meyer was detached from the Knight
Ridder Washington Bureau to the Detroit Free
Press to report on the Detroit riot. His applica-
tion of social science research methods, learned
in Harvard’s Nieman Fellowship program, helped
the staff win the Pulitzer Prize for general local
reporting.

Knight Ridder later moved him to corporate
headquarters to apply those methods to newspa-
per marketing and the development of an early
electronic information service called Viewtron.
His 1985 book, “The Newspaper Survival Book,”
is based on that work.

Foreword
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where,” is no longer so convincing. We need good reporters who can bring appro-
priate tools to bear on constantly changing situations. In this environment, 
journalists who can do more than one thing well will be in demand. Economics
and deadline pressures will ensure it. 

Mark Briggs is the assistant managing editor for interactive news at the Tacoma
News Tribune. In that job, he can see the problem up close. Although he holds
two journalism degrees, the most
recent in 2000, he had to educate
himself to use the current tools of
digital media. He quickly saw that
his job would be easier if more of
the paper’s staff had workable
knowledge of more of the tools.

And so he wrote this book. You can
use it like a cookbook. There are
recipes, up-to-date, for all kinds of
things digital. When I read it, I kept
wanting to stop and try something, for instance, setting up an RSS feed, convert-
ing my old audio tapes to MP3 files, and changing my default browser to Mozilla
Firefox. (There is some irony here, because this volume is a rousing reaffirmation
of the book as an information retrieval device. Its content can be accessed in any
order, connect time is free, and you can carry it to the coffee shop.)

Journalism schools are struggling these days with the issue of how deeply to let
students sink into specialties. The gathering consensus is that everyone should
know how to do one thing well but be able to work at least in the margins of the
other crafts. But as technology and media economics push us toward platform
convergence, a new model emerges: The journalist who is a jack of all trades and
master of none, a person who can write, shoot, edit, talk, and look good on cam-
era with a competence that might not be great but is good enough. A good
reporter would be redefined as one who is good enough in any medium.

If that picture seems too unlikely, we can at least be certain that versatility will
be rewarded. And because technology keeps changing, journalism schools might
do better if they would focus less on the craft and concentrate on basic theory 
of mass communication and its effects. Such a concern for first principles might
produce more journalists like Mark Briggs, who know how to keep on learning 
and revising the craft throughout their careers and, as he demonstrates with this
volume, help their peers to learn. 

... journalists who
can do more than
one thing well will
be in demand.



“In print it’s easy
to feel you are at
odds with readers
because people
will find one little
thing wrong. So as
a journalist you
get defensive. The
readers on a blog
chime in and help
you. They want
you to get the
story right.” 

— Ben Mutzabaugh
USAToday.com Business Travel columnist
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A Smooth Sea Never Made 
a Skilled Sailor
This is a book about people, not technology. Sure, there’s a lot of technology in
the pages to follow, but if you boil it all down to its core, its essence, you’ll find
people trying to extend a noble and grounded craft into a new and unpredictable
landscape. And it’s the people who matter, not the latest software or Web site. If
the people in this equation learn how make technology work for them, the rest is
just details.

As journalists, we need to change our practices to adapt, but not our values.
We’re like sailors in the English proverb I chose for the title to this introduction:
No amount of wishing for a return to smooth seas will calm the water around us. 

To carry the sailing metaphor even further: It’s time to tack. It’s time to turn the
bow of our ship and make the wind in this new sea work for us, not against us. 

We’ll use the best practices of other working journalists to point the way. We’ll
draw from the groundbreaking and innovative work being done at newspapers,
radio and television stations and Web sites around the U.S. We can learn from
their experiences.

As Benjamin Franklin famously said, “When you’re finished changing, you’re 
finished.”

The future is now 
There’s never been a better time to be a journalist. That might sound odd consid-
ering how many newspaper journalists lost their jobs since 2000 (3,000),1 but
there has never been a time that offered so many powerful ways to tell stories
and serve readers with information. If you love journalism, you have to love hav-
ing more tools at your disposal, more interaction with your audience and the near
disappearance of traditional constraints of time and space. 

Introduction
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Sure, times are tough on the business side. If you think about print news products
— daily and weekly newspapers and magazines — in marketing terms, everyone
knows about these products and knows how to use them. As a marketer, that’s an
enviable position to be in when trying to sell something. Yet sales are declining
every year (or every month at some publications). Why? One reason is that the
digital economy has transformed that marketplace for news and information from
one of scarcity to one of abundance (see Chris Anderson’s “The Long Tail”2). In
today’s landscape many people don’t want to pay a few pennies every day for a
product they may not use every day and they have to dispose of every day.

But this product in all its forms — journalism — is worth saving. It creates com-
munity on so many levels. And it creates marketplaces that are essential to the 
continuing viability of entire companies. Newspapers had a virtual monopoly on
their marketplaces for decades. That’s ending now so the trick is to create new
marketplaces before old ones completely disappear. Not necessarily to replace
them right away, but to complement and support them.

“No longer are we purely media companies; we must become technology compa-
nies, too, and that means we must raise our technology IQ to compete in a digi-
tally transformed world,” Michael Riley, former editor of The Roanoke (Va.) Times,
wrote in the December 2006 issue of Nieman Reports. “A big part of our success
will be tied into rethinking what type of people we hire. The premium, moving
forward, will rest on attracting more innovators into our midst and finding ways
to give them the freedom and the backing they need to experiment and help
move us into a new realm in which we can preserve the journalism and make a
robust business model work.”

He’s right. We need new and different thinking in news organizations to survive
and thrive in this new media landscape. But that doesn’t have to mean new and
different people. This innovative thinking could come from the same smart and
dedicated people who have thrived practicing journalism since before the Internet
changed the game. 

You just need to know the rules, the terms and the motivation. 



Introduction
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You can do this
Can you cut a word in your copy and paste it into a different location to help 
the sentence flow? Then you have what it takes to edit audio and video.

Can you send an attachment with an e-mail? Then you have what it takes to 
publish a blog with pictures.

With a little practice and experience, digital journalism will actually save you
time. Talk to any newspaper reporters who have successful blogs and ask them if
it takes more time out of their week because they’re doing “extra” work. The
answer likely will be “no.” How can that be? The blog turns out to be a great

organizational tool for beat
reporters. It’s a notebook kept in
the public sphere so reporters
know which topics have “juice,”
helping them prioritize the sto-
ries they should work on.

Go find someone who works on
the Web site for a news compa-
ny. Ask them how they learned

to do what they do. In almost all cases I would wager that they are self-taught.
It’s simply the result of wanting to learn something new. 

That’s the secret: If you truly want to learn how to do digital journalism, you
will. Remember, this is about people, not technology.

This handbook will guide you along the way, breaking down each skill and
technology into digestible lessons that will be immediately usable for you in your
work. It is organized so you can focus on one discipline at a time. It is practical,
not conceptual. You will be able to perform the skill the same day you read about it.

It has to be that fast — there is no time to waste. 

The fact is, if you work in journalism, you work for an online news organization
— whether you want to or not.

Change is inevitable. Progress is optional. The future is now. 
– Mark Briggs

1 American Society of Newspaper Editors, Newsroom Employment Census, 2006. Numbers are for paid-
circulation newspapers.
2 The Long Tail, Hyperion, July 2005. Chris Anderson is editor-in-chief of Wired Magazine.

Change is inevitable. 
Progress is optional. 

The future is now. 
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Chapter 1:

FTP, MB, RSS, oh My! 

To “survive and thrive” in the digital age, you need to know the lay of the

land. Here are some concepts and terms to give you the foundation needed to

tackle the fun stuff. This chapter will also discuss how to make RSS (Really

Simple Syndication) technology work for you while giving you an understanding

of what it means for your readers.

This journey toward the new begins with the basics — and this

means learning the characteristics of the Web. A journalist

might ask why anyone needs to know something so seemingly

arcane as the characteristics of a communications medium, but

when you don't know how a game — football, soccer, baseball

— works, it’s hard to play it. And if you don't understand 

foreign words, you can’t speak the language. 

– Jane Ellen Stevens teaches multimedia reporting at the Graduate
School of Journalism at the University of California at Berkeley.
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Introduction:
Today’s special? Acronym soup
Get ready to go digital.

Think of the many difficult concepts you have mastered in your reporting, your
photography or your management. Technology is no more complex than growth-
management standards, the open-meetings act, or computing the earned-run aver-
age for a pitcher in baseball. You’re smart — you just have to open your mind to
something new. 

If you’re reading this, you’ve won half the battle. More than half, actually.

One of the barriers that prevent people from more deeply understanding how the
Internet and other technologies work is the slew of acronyms that are used. This
chapter will break those apart and define the basic concepts of technology that
will be helpful to your daily work life now that your work includes a Web site. 

Digital information: Megabytes, 
gigabytes and terabytes
In the ensuing chapters, you will learn to create several types of digital files:
Audio files, photograph files and video files. It is important that you understand
how to “weigh” these files since, as we will soon discuss, the larger the file size,
the longer it takes to download over the Internet.

When it comes right down to it, this whole digital evolution can be explained in
bits and bytes. A byte is a unit of measure for digital information. A single byte
contains eight consecutive bits and is capable of storing a single ASCII (pro-
nounced as-kee) character.  

The American Standard Code for Information Interchange (ASCII) first published a
standard in 1967. It defines the 95 printable characters that are the text in com-
puters and communications devices. Essentially, it’s everything on your keyboard:
letters, numbers and basic symbols like % and &.

To make it easier to talk about a lot of bytes, we use prefixes like kilo, mega and
giga, as in kilobyte, megabyte and gigabyte (also shortened to K, M and G, as in
KB, MB and GB). The table on the next page shows the number of bytes contained
in each. 
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You can see in this chart that kilo is about a thousand, mega is about a million,
giga is about a billion, and so on. So when someone says, “This computer has a
40 gig hard drive,” that means the hard drive stores 40 gigabytes, or approxi-
mately 40 billion bytes. How could you possibly need 40 gigabytes of space? Well,
one CD holds 650 megabytes, so it won’t take long to fill the whole thing, espe-
cially if you have a lot of music and digital photographs. Petabyte databases are
actually common these days, from the Pentagon to such major retailers as Sears,
who use them to store customer data. 

Name Abbr. Size
Kilo K 1,024

Mega M 1,048,576

Giga G 1,073,741,824

Tera T 1,099,511,627,776

Peta P 1,125,899,906,842,624

Exa E 1,152,921,504,606,846,976

Zetta Z 1,180,591,620,717,411,303,424

Yotta Y 1,208,925,819,614,629,174,706,176

Source: Marshall Brain, “How Bits and Bytes Work,” April 1, 2000. 
http://computer.howstuffworks.com/bytes3.htm (January 27, 2007).

Think of it this way: A petabyte is the equivalent of 250 billion pages of text,
enough to fill 20 million four-drawer filing cabinets. Or imagine a 2,000-mile-high
tower of 1 billion diskettes.

So what does it mean? For starters, you should never send an e-mail with an
attachment larger than 1MB or you will clog your server and the server of the per-
son you’re sending it to. And you should especially never send an e-mail with a
large attachment such as a photo to a group list. The server will have to make
copies of your large file for everyone on the distribution list. (Instead, copy it to
a USB drive, burn it to a disk or upload it to an FTP server. More on this later.)

You should also begin to recognize how large the files (PDFs or video clips) are
that you download from the Web. Note how long it takes to download a file that
is 500KB versus one that is 5MB. It’s part of the digital literacy lesson you’ve
begun to learn.
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This is important for online publishing because the speed of an Internet connec-
tion plus the size of the file to be downloaded determines how fast someone can
download your content. If it’s just text, like a news story, it’s probably only a few
KB and will download quickly, even over an old 56K dial-up modem. 

Note: The “56K” refers to the transfer rate per second of digital information. So
dial-up users with 56K modems can’t expect to download information over the
Internet faster than 56KB per second.

How the Internet works
As you probably know, the Internet refers to a series of computers that are con-
nected and share information. A Web server is a special type of computer that
stores and distributes/presents information over the Internet.

But how does it know which information to serve? The URL (uniform resource
locator) or Web address is the key and is very similar to how you receive mail at
your home or office. Although you recognize a Web address like www.yahoo.com,
Web servers know that location as 209.73.186.238. That’s the IP address (IP =
Internet Protocol), which is a unique, numeric identity of a Web server location.
All Web addresses have corresponding IP addresses that computers recognize but
people never would. Registering a domain name secures a human-readable Web
address and associates it with a numeric and computer friendly IP address. 

Internet vs. World Wide Web: Contrary to popular belief, these two terms do not
mean the same thing. The Internet refers to the network of connected computers
that share information. The World Wide Web refers to a way of accessing informa-
tion through the Internet using the hypertext transfer protocol (HTTP) and Web
browsers. It does not include other protocols such as e-mail, instant messaging
and file transfer (FTP).

About Web browsers
The Web browser is the tool that people use to access over the Internet informa-
tion that is published as part of the World Wide Web. It is software that you know
as Internet Explorer, Safari or Firefox and it does three important things:

1. It searches and finds information.
2. It retrieves information and brings it back to you.
3. It renders the information for display on your computer.
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When a browser retrieves a Web page and brings it back to you, it makes a copy
of the various pieces that make up that particular Web page and stores those files
on your computer. This is called the cache.

The cache is a temporary storage of all the files you download during your Web
browsing. You can adjust the settings on the cache in your browser to store a lit-
tle or a lot of these temporary files. It’s a good idea to clear your cache regularly
to help your browser run efficiently. It also deletes unneeded temporary files from
your computer, which helps your entire system run better.

Managing your browser’s cache:
• Firefox 2.0: To clear the cache, select Tools then Clear Private Data. To limit

the size of the cache, select Tools then Options and click on the Network tab.

• Safari: Click on Safari in the top menu, then select Empty Cache.

• Internet Explorer 7: To clear the cache, select Tools, then Internet Options.
Click the Advanced tab. Scroll down to Security and check “Empty Temporary
Internet Files folder when browser is closed.”

To make sure the browser is showing the most updated files for a Web page, use
the Refresh button (or hit F5 on your keyboard). This tells the browser to go back
to the Web server and get new copies of all the files that make up that particular
Web page. 

A final note about Web browsers: If you haven’t tried a new Web browser lately,
you should. These programs are constantly updated and improved. Especially 
recommended is the Firefox browser, which is a free download. It was developed
as an open-source project and at the end of 2006 was being used by almost 
one-third of Internet users. That’s quite a remarkable feat given the advantage
Microsoft’s Internet Explorer has. (It’s preloaded on all Windows machines — 
92 percent of the market — and is set as the default browser.)

These are the refresh buttons for
Firefox, Safari and Internet Explorer
7 and 6.
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Plug-ins and extensions
Modern Web browsers can display more than just text and graphics but usually
need the aid of plug-ins or extensions. Popular add-ons include Adobe Acrobat
Reader (for PDFs), Flash (for animation), and media players such as QuickTime,
Windows Media Player and Real Player. 

RSS readers and feeds
How to make RSS feeds work for you: If you’ve ever received an e-mail “News
Alert” from Google or Yahoo! on a search term that you set up, you understand
the depth of information available on the Web and the need for smart technology
to help you track it. E-mail, however, is not an efficient tool for tracking dozens
or even hundreds of topics. RSS can do it, though, and help you track that many
topics with the click of a mouse.

“RSS is an important way of tracking what multiple people are saying about 
a certain subject,” said John Cook, a business reporter for the Seattle Post-
Intelligencer. “Also, a number of the companies I track keep blogs, so 
putting their feeds into my RSS reader is one way to stay up on what they are
doing. With so much being written these days, this is one way to track what 
is going on.”

“RSS feeds make it possible to consume far more information at a faster pace than
would otherwise be possible for the human brain,” Marshall Kirkpatrick wrote on his
blog (www.marshallk.com). Kirkpatrick is a well-known technology blogger who uses
RSS to keep track of daily technology developments “without breaking a sweat.” 

RSS basics
RSS stands for Really Simple Syndication, which is a great name because the
concept is just that: Really simple. It allows you to subscribe to an information
feed that gets delivered directly to your RSS reader or Web browser. So instead of
visiting several different Web pages each day or performing the same Web search-
es over and over, you can set up RSS feeds to do it for you. 

Why RSS? RSS is still emerging as a tool for Internet users. Since it’s a free sub-
scription, Web publishers — news sites especially — love it for the consistent
delivery of content. It’s also part of a growing movement away from consuming
Web content by first going to a home page. Some industry figures suggest that 30
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to 40 percent of traffic to news Web sites begins on an article page, not the home
page. RSS is part of the reason for that. (Searches on Google and Yahoo! are a
bigger reason, of course.) 

Some RSS feeds only give the reader the first paragraph of an article and force a
user to visit the host’s Web page for the rest. This protects a Web site’s traffic num-
bers and ad-serving opportunities, but it can frustrate readers and is counter to the
idea of making it as easy as possible for the audience to read your material.  

When the Los Angeles Times announced a major reorganization in January 2007,
it made RSS technology a focal point for how it planned to emphasize publishing
digitally first and for the printed paper second. The announcement followed a
similar move by Gannett in 2006. 

“We are rebuilding our business to reflect how readers, users and advertisers are
using media today,” David Hiller, publisher and CEO of the Times, said in a state-
ment. “People choose different platforms and products to meet their varying news
and information needs throughout the day, and we are positioning the Times to
be there when they turn to us.” 

With the announcement, the company launched a new version of its flagship Web
site: MyLATimes.com. The site uses RSS feeds to deliver content directly to com-
puter users based on their interests. It is similar to the personalized home pages
offered by Yahoo! and Google for years.

MyLATimes, an RSS-based personalized Web page.
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“Our philosophy going forward is, ‘Break it on the Web, expand on it in print,’”
said Times editor Jim O’Shea. “We have to change what we are doing online, and
also in print, to better engage readers and users who can choose every day among
myriad sources for their news and information.” 

How does RSS work? When you subscribe to RSS feeds, you create a convenient,
one-stop information shop tailored to your needs and interests. Setting up a feed
is similar to bookmarking a Web site, but it’s much more efficient and powerful.
And it’s really easy to get going. Here’s how: 

1. Select a reader.

2. Find a feed.

3. Add it to your reader.

Select a reader: There are essentially two types of RSS readers to choose from.
Web-based readers that you access by logging in to a specific Web page, or stand-
alone software programs that you download to your computer and then launch. To
understand the difference between Web-based readers and stand-alone versions,
think of having a Hotmail account that allows you to check your e-mail from any
computer (with Internet access) compared to using Outlook or Entourage, which
you can only use on your computer.

Web-based readers: Personalized home pages provided by Yahoo! and Google
(among others) use RSS feeds to build a Web page with links to the information
you choose. It’s easy to do without ever knowing how RSS actually works. Simply
go to my.yahoo.com or www.google.com/ig, sign up for an account and select the
information you’d like to receive automatically, then arrange the feeds on your
page the way you want
them to appear. (You
can move them around
by simply clicking and
dragging the boxes.)
Each time you return,
the links will be updat-
ed automatically with
the latest information
from those Web sites. 

A MyYahoo! start page
with RSS feeds selected
from Yahoo’s menu.
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Stand-alone readers: There are dozens of freely downloadable RSS readers that
act like Web browsers. You set up your feeds and then launch the software each
time you want to access the information. One benefit to stand-alone readers is
the ability to download feeds when you have Internet access and then read them
when you don’t (on an airplane or train, for example). Some popular options to
consider include NetNewsWire, NewsGator, Pluck, FeedDemon and SharpReader.

Because of their folder structures, stand-alone RSS readers like NetNewsWire
(for the Mac) and SharpReader (Windows) work well. You can set up folders and
subfolders according to the importance of the topics. The software will tell you
how many items (new and total) are in each folder so you can quickly glance
through the list to find any new items. It looks and acts a lot like a standard 
e-mail program.

A screenshot of RSS feeds organized in folders using SharpReader.

You will probably find that the more feeds you add, the more you will discover 
as you follow links in blog posts and news articles. If you don’t find anything
interesting about a feed a few days after subscribing to it, simply delete it.

Best of both worlds: Netvibes, PageFlakes and the Google Reader are also good
options if you want the functionality of stand-alone software (the folder struc-
ture) with the convenience of access on multiple computers. 

NOTE: To find any of the software mentioned above, simply run a search on Google
or Yahoo! for the name.
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Find a feed: Locate a link to RSS on the Web
site with the content you want to receive
automatically. Often, a little orange icon will
signal the availability of RSS.

Most news Web sites have an index page 
with dozens of feeds available. On the 
right is a partial list of feeds available on
washingtonpost.com.

Click on the link to obtain the RSS URL,
which you will see in the “address” field of
your browser. Simply copy this URL and fol-
low the instructions for your particular news
reader to subscribe.

If you click to subscribe to Howard Kurtz’s
Media Notes, you will be taken to a page
with the following Web address:
http://www.washingtonpost.com/
wp-dyn/rss/linkset/2005/03/24/
LI2005032401283.xml

Modern Web browsers such as Firefox and Internet Explorer will recognize a URL
that ends with “xml” and automatically take you to a page that allows you to
quickly add the feed to your reader. Here’s what that page looks like in Firefox:
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What should you subscribe to? 

• Sections on news Web sites that are targeted to your interest or beat.
• Any blog that discusses a topic of interest (not so much for what the blogger

says, but for the links he or she finds).
• Blogs by companies you cover.
• Web searches such as Google News Alerts on terms, names of people and 

companies that you want to track.
• Content from your own Web site that is worth tracking, such as most popular

stories or letters to the editor.

Adding a Web search to an RSS reader is also easy. 
1. Perform the news search (in Google News or Yahoo! News).
2. Click on the RSS icon or link on the first results page (see arrow on 

screenshot below).

3. Copy and paste the URL into the Web address window on your RSS program.
4. Hit Subscribe.

NOTE: If you have Firefox 2.0 or Internet Explorer 7 you can skip step 3 and select
your RSS reader from the dropdown menu and click on the “Subscribe” button.

Instant messaging
Do you IM? If not, maybe you should. While it is famous as the bastion of teens
and pre-teens, this method of communication is also incredibly effective for
organizations where lots of folks work in the same building, but not geographically
close enough to speak to one another.
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Several times each day, there is a question or comment you would make to some-
one if that person were standing next to your desk, but it doesn’t quite merit a
phone call or an e-mail. (You’re respectful of others and only send e-mail that is
important to avoid cluttering your colleagues’ inboxes.) That’s where IM comes in.
It’s informal, quick, efficient and actually kind of fun. 

Of course, that also presents problems for employers. Some staffers have found it
easy to chit-chat over IM. As a result, some employers have added tracking soft-
ware to capture IM exchanges on the company servers, meaning you shouldn’t
write anything on IM you wouldn’t say in public. A few companies now prohibit its
use due to continued abuse, so check with your Information Systems department.

Still, using IM will also give you additional experience with
your new digital life. Used properly, it will add efficiency to
your operation. You will also experience the culture of emoti-
cons (the little graphic smileys) and text shortcuts that are
now commonplace among younger, tech-savvy users. 

To get started, use iChat if you’re on the Mac (it’s already
installed) or Trillian for Windows (a free download). Set up an
account with AOL or MSN and ask others in your building for
their “handles.” (A handle is a nickname that chat software
uses for identification; you select your handle during your
account setup.) Build a “buddies list” and you’ll now be able to
see who’s online whenever you launch your chat program.

File Transfer Protocol   
A simple process for moving those big files that e-mail can’t handle is called File
Transfer Protocol (FTP). There are dozens of free software programs available to
execute the task. 

Digital audio and video — and some PDF and PowerPoint files — can exceed 
1MB in size. Some video files even exceed 1GB. It’s not a good idea to transfer
files larger than 1MB with e-mail since most network servers are not capable of
handling them. (Third-party e-mail programs such as Gmail handle them pretty
well, however.) 

The best way to move a big file between computers is with a free FTP program.
FileZilla, Coffee Cup and Ace are FTP programs I’ve used successfully on the
Windows platform. For the Mac, Fetch, Cute FTP or Cyberduck will do the trick.
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buddies list.



Or, if Firefox is your browser (and it really should be), you can download the
FireFTP plug-in and add FTP capability to your current browser.

NOTE: The Firefox browser by Mozilla is used by 31% of Internet users (as of
February 2007)1 and has erased the dominance of Internet Explorer because of its
intuitive user interface, efficient page loading, tabbed browsing and copious free
plug-ins that allow for easy customization. If you haven’t switched to Firefox yet,
I recommend giving it a try.

When would you use FTP? Use it if you have shot some photos or video or record-
ed some audio and you want to publish it online on your Web site with the story
you are working on. All you need to transfer a large file (or files) over the
Internet, besides some free software, is the account information of the server
where you want to send the file. If you are hoping to upload a large file to your
Web server, get the account information from your Web staff. It will look like this:  

Account name: Newspaper FTP (this is optional — something you create for yourself)
Host: ftp.newspaper.com
Login: crazyfiles
Password: !secretstuff%

Most FTP programs save the information the first time you enter it so you’ll be
able to easily return and send additional files with one or two clicks. 

The setup for most FTP programs is the same: A folder layout on the left side of
the interface that reflects the file structure of your computer, and a folder layout
on the right side that reflects the file structure of the FTP server. Navigate to the
folder where you want to
copy the target file (if that
folder is not already visible),
then find the file in your file
structure, click and drag it
across. It’s that easy.

NOTE: To find any of the
services mentioned above,
simply run a search on
Google or Yahoo! for the
name. 
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Summary
If you make the effort to add RSS and chat to your daily digital life, you will
quickly increase your digital literacy. While it may not have a direct effect on 
your next assignment, it will open up another world for you that will certainly 
pay dividends in the near future.

Assignment:
1. Start instant messaging.

2. Set up RSS feeds.

3. Sign up for an e-mail newsletter.

4. Create a News Alert at Google or Yahoo!

5. FTP a large file to your Web server.
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Chapter 2:

Web 2.0

This chapter delivers a basic overview of the new technologies and Web sites —

such as MySpace, Flickr, OhmyNews, Wikipedia and del.icio.us — that have

changed the way people consume news and information and what it means for

newspapers.

Welcome to Web 2.0 
The term “Web 2.0” refers to Web sites that get at least some of their value from
the actions of users. Often the concept is compared and contrasted to “Web 1.0,”
a retrofitted term describing the construct and limitations under which much of
the current Web was constructed, with the concept of home pages, intrusive serv-
ices such as opt-out marketing and barriers to site content such as registration.

The “old Web” wasn’t all bad, of course. Traditional media organizations and brick-
and-mortar businesses built sturdy if unspectacular Web sites that didn’t go away
with the dot-com boom. They experimented with new ways to reach audiences
and customers and many, like e-mail newsletters and Amazon’s customization, still
thrive today. These attempts at innovation laid the groundwork for a second
round of experimentation that was more open and attempted to harness the
power of the user. 

“Change starts at the edges. That’s where people — our readers and viewers —
probe new practices. That’s also where their emerging culture is forming, a culture
in which they look at media from a different perspective,” Francis Pisani1 wrote in
the December 2006 issue of Nieman Reports. “And so journalists’ new thinking
needs to begin at the periphery, where change comes quickly among the younger
generation of users, and a lot more slowly for us. Tomorrow’s potential readers are

Chapter  2: Web 2.0
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using the Web in ways we can hardly imagine, and if we want to remain significant
for them, we need to understand how. Yet news organizations have been all too
slow to notice movement in places that are away from what has been their center.”  

Web 2.0 is all about openness, 
organization and community
It’s all about open — open-source software allowing users control and flexibility,
open standards to allow new creation. Web publishers are creating platforms

instead of content. Users are creat-
ing the content. This is the move-
ment that led Time magazine to
declare “You” as the Person of the
Year, explaining, “In 2006, the
World Wide Web became a tool for
bringing together the small contri-
butions of millions of people and
making them matter.”

Journalists know Wikipedia. Most have seen MySpace, though they might loathe
it. They’ve surely seen something hysterical on YouTube, even if it was a Stephen
Colbert piece. And eBay is old hat by now. These sites, better than most, illus-
trate the power of Web 2.0, especially for ordinary Web users. They are powered
by one or both of the basic tenets of this new era for the Internet: 

• Web sites that are no longer isolated information silos with one-way communi-
cation channels (one to many) but rather sources of content and functionality,
thus becoming computing platforms serving Web applications to end users.
Take MySpace. It succeeds where GeoCities failed because it’s easy for users to
post audio and photos, keep a blog and have visitors freely comment on the
content to further the flow of communication. The once-popular GeoCities,
meanwhile, allowed users to create static home pages for their content with no
interactivity or additional functionality. 

• An approach of creating and distributing Web content that is characterized 
by open communication, decentralization of authority, freedom to share and
re-use, and the idea of “the market as a conversation” (many to many). In 
the 1.0 model, a Web publisher (whether a news site or a personal site on
GeoCities) would upload content to a Web site for many others to read and the

Web publishers are
creating platforms
instead of content.
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communication transaction would end there. The 2.0 model not only allows
those “many others” to comment and add to the content posted by the pub-
lisher, but they — the audience — can also add original content themselves.

By designing Web software that uses community input and interaction as its con-
tent, sites such as Wikipedia, MySpace, YouTube and Flickr created sophisticated
warehouses of content — without creating any content at all. It is still creation,
of course, but an upside-down model for creation when compared to the tradition-
al methods anyone over 30 has grown up with. 

Google, meanwhile,
changed the economics
around advertising without
ever hiring a sales rep and
powered the business side
of the equation for much
of Web 2.0. 

Let’s take a closer look at
each of these phenomena:

Google needs no introduc-
tion to journalists thanks
to its marvelous search engine. But the company didn’t make money off the mil-
lions of daily search queries until it launched AdSense in 2003. With this new pro-
gram (inspired by an existing company called Overture), Google allowed communi-
ty members to set the price for ads they could place on the site with a self-serv-
ice application. 

An advertiser picks a keyword or search term and tells the system how much it
will pay if a Google user clicks on its ads. When a user performs a search with
that search term, the advertiser’s ad appears. If the user clicks on it, then Google
charges the advertiser. 

To extend the scale of pay-per-click
advertising, Google created a sys-
tem so all content publishers could
run the Google ads on their sites.
So instead of search terms, the
Google robots (computer programs
that continually “crawl” the Web,
indexing the content) scan the text

... sites such as You Tube
created sophisticated 
warehouses of content—
without creating any 
content at all.

Google ads from Miami Herald Web site home
page, Dec. 19, 2006.
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of a content page and display ads that are keyed to match any of the prominent
terms on the page. If a user on an affiliate site clicks on an ad, Google (again)
charges the advertiser and then kicks an unspecified percentage to the publisher
of that site. 

In 2005, Google reported more than $6 billion in advertising revenues (source:
http://investor.google.com). One year later, the company broke the $10 billion
mark for 2006 ad revenue. All this without hiring a single sales rep.

Journalists also love Google Maps, which is a great example of Web 2.0, because
anyone can use the code to create new services based on the maps. For example,
journalist/computer programmer Adrian Holovaty took a feed from the Chicago
Police Department and combined it with Google Maps to produce the award-win-
ning site chicagocrime.org. Other Web sites have mapped cheapest gas prices, free
wireless Internet hot spots, bars and restaurants with happy hours and more (see
Google Maps Mania at http://googlemapsmania.blogspot.com/). 

This openness contrasts greatly with companies such as Microsoft and AOL that
dominated the age of Web 1.0, where everything was proprietary and controlled.
Microsoft’s MapPoint, for example, hit the market a few years before Google Maps.
But since it was developed without open access (you couldn’t use it without a
Windows machine and it wasn’t free), programmers did not rush to build tools
with it. 

“The Web naturally has a certain grain, and Google is aligned with it,” author Paul
Graham2 wrote and was quoted in “The Long Tail” by Chris Anderson. “That’s why
their success seems so effortless. They’re sailing with the wind, instead of sitting
becalmed praying for a business model, like the print media, or trying to tack
upwind by suing their customers, like Microsoft and the record labels.”

In 2006, MySpace became the most popular Web site on the planet in terms of
page views. The site claims more than 100 million users (as of September 2006)
and served nearly 39 billion page views in November, according to comScore
Networks. News Corp. purchased the site in 2005 for $580 million. 

By registering and filling out profiles, users create the content. They use “blurbs,”
“interests” and “details” sections to present their online persona, and communi-
cate with blogs, photos, video and comments. Teens and twenty-somethings
flocked to the site almost immediately. While it gave them an easy way to com-
municate with one another, it also has drawn criticism as a haven for pedophiles
and sexual abusers, creating fear and angst among parents and creating another
area for the legal community to monitor. That said, it has also grown into an



effective marketing tool for musicians, filmmakers, comedians and small businesses
such as bars and nightclubs.

YouTube was founded by three former employees of PayPal, the online banking
and payment firm that powers much of the commerce on eBay. YouTube launched
in February 2005 and quickly became one of the most popular sites on the Web,
growing faster even than MySpace. Its slogan is “Broadcast Yourself,” which is
exactly what millions of people have done, sharing home movies and amateur
films with whoever will
watch. Plus, video blogging
(on-camera commentary)
has taken off with the help
of YouTube.

The downside for the site 
is that many people have
uploaded other people’s
content. TV networks
claimed copyright infringe-
ment, and some of
YouTube’s most popular 
clips have been removed,
including a skit called “Lazy
Sunday” from “Saturday

MySpace.com home page.

YouTube.com “Most Viewed” videos page.
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Night Live.” In June of 2006, however, NBC reversed field and partnered with
YouTube to establish an official channel on the site that will display promotional
clips from its shows.

With hundreds of thousands of video clips on its site, YouTube’s Web 2.0 struc-
ture helps visitors find compelling content quickly. Users can choose from Most
Recent, Top Rated, Most Viewed and Most Discussed, which conveniently allows
someone to find the next true buzz clip.

In October 2006, Google purchased YouTube for $1.6 billion worth of stock.

Flickr, which launched in
February 2004, was devel-
oped by Ludicorp, a
Vancouver-based company.
One year later, Yahoo!
bought the photo-sharing
Web site but has done lit-
tle to integrate it into its
massive portal. 

Flickr is more than a place
to share personal photo-
graphs. It’s also a commu-
nity platform that uses
tags to power its organiza-
tion and makes photos of
specific topics easy to find.
It also has slick functionality for bloggers, who can store photos on the site and
display them on their blogs with a few simple clicks. 

Tags and folksonomy: New ways to organize content

Participants in the Web 2.0 revolution use tags to catalog content that they cre-
ate or just find. Tags are informally chosen and not part of some formally
defined classification scheme. This is called a folksonomy and contrasts with a
taxonomy since the structure is defined by the users and is constantly changing. 

Bloggers use tags that can be traced in search engines like Technorati and Ice
Rocket. Photographers use tags to organize photographs on photo sites like
Flickr. Web browsers use tags to share appropriate sites with others who have simi-
lar interests on del.icio.us. Even Gmail, Google’s e-mail service, allows categoriza-
tion by tags.

Flickr.com allows you to search by subject tags, such as
architecture.

30
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e



A tag cloud is an automatic
way for a Web site to dis-
play its tags, giving more
prominence to popularity.
Computer code generates a
tag cloud and displays the
more popular tags with a
larger font so the audience
quickly sees which tag has
the most activity or content
associated with it.

Can you Digg it?
Web 2.0 loves the wisdom of the crowd and few sites illustrate that better than
Digg. Along with the venerable geek site Slashdot and newcomers Reddit and
Newsvine, these news sites rely on readers to submit and promote articles from
other Web sites. So the sites — while widely considered to be news sources (all
but Newsvine concentrate on technology) — actually publish no news. Digg
users find interesting content elsewhere online, then submit the links and sum-
maries on Digg for consideration, then other Digg users “vote” for stories they
like by giving them Diggs. If a story gets enough Diggs, it ends up on the front
page of the site.

The Digg effect can be seen on many mainstream news sites that have added a
list of the most read,
most e-mailed or most
printed stories to their
Web sites. While they
clearly aren’t ready to
surrender all news judg-
ment to the crowd,
most Web editors rec-
ognize there’s power in
what others have found
interesting on the site
instead of solely relying
on their more tradition-
al view of what’s news.

Tag cloud from Flickr.com on Jan. 31, 2007.

Digg.com’s News page.
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What does this mean for journalism?
Readers are no longer passive receivers of our messages. They create, share and
comment. And they expect to do it on news Web sites, too.

Jay Rosen, journalism professor at New York University and author of the Press
Think blog, has coined the concept of “The People Formerly Known As The
Audience.” (To read more about it, Google “TPFKATA.”) This recognition of the
fundamental change in how messages are received from mainstream news organi-
zations turns on its head the lesson most of us learned the first day in
Communications 101: We send, they receive. 

This idea has also come to be known as “news is a conversation, not a lecture.” 

It is important to recognize the change in your audience. They want to partici-
pate, so help them. Many traditional news organizations include e-mail links on
news stories to make it easy for readers to contact the reporter and ask questions
or comment on stories. Some have taken the next step and allow readers to com-
ment directly on the story online for all to see. 

If you have the opportunity, read the comments posted on your stories and write
to those who deserve it. Be proactive in seeking feedback on stories before they
are published. It can be as simple as posting a “call to readers” in the newspaper
or as advanced as assembling an e-mail list of good targets. For example, if you
cover education, build a list of teachers and administrators and send e-mail blasts
when you need general comments for a story (more on this later). 

Even if you’re not ready to collaborate with your readers on reporting and writing,
you can take advantage of Web 2.0 technology. Sites that employ tagging, for
example, are useful in reporting on niche topics (del.icio.us chief among them).
Use them to organize your searches and to see what other tags related to your
beat are popular.

Don’t know where this is heading?
Part of the difficulty for traditional journalists is that we’re not very good at mov-
ing forward when we don’t know where we’re going. No one knows how all of this
is ultimately going to change what we do or what opportunities this new model
presents for us. But the only way we’ll be able to take advantage is if we’re aware
of the technologies and actively participate in the changing landscape.



“RSS and tagging are tools I use to track and obtain information in a more timely
manner,” said John Cook, a business reporter for the Seattle Post-Intelligencer.
“So in that way, they are helpful to me in publishing information quickly online.” 

Assignment: Take part in the revolution
To understand fully how Web 2.0 works, you need to use these sites. Open
accounts at all of them and test drive the services they offer. Each of these
assignments should take you less than a half hour. If you do one per day,
you’ll get through all four steps in a week. 

1. Upload photos and apply tags to them at Flickr.

2. Find a handful of Web sites that are interesting to you and tag them on
del.icio.us.

3. Visit Technorati and browse blog content using tags.

4. Visit Digg, Slashdot, Reddit and Newsvine and compare the news stories
you find there with your regular news sources.

1 Francis Pisani, “Journalism and Web 2.0,” Nieman Reports, December 2006. Francis Pisani is a free-
lance blogger and columnist covering information technology and new media in the San Francisco Bay
area for several European and Latin American newspapers.

2 Anderson, The Long Tail, page 70. Paul Graham is a popular author and Lisp programmer who wrote
“Hackers and Painters: Big Ideas from the Computer Age.”
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Chapter 3:

Tools and Toys

The Treo, the BlackBerry and the iPod have forever altered the way our audiences

access media. In this chapter, learn how people are using these toys and others to

access your content and how to make your content more accessible to them.

Introduction
As disruptive as Web sites have been to the traditional publishing and broadcast-
ing model, we ain’t seen nothin’ yet.

The digital landscape is awash in change. Before you learn the basic skills that
will allow you to participate in the digital revolution, it’s important for you to
look at the lay of the land through a broad lens. New and evolving technology
and gadgets have changed — and will continue to change — the markets that
news operations are aiming to serve.

I will start with information about some tools you should be using and then 
discuss tools you should understand that others are using. Not everyone wants 
to watch movies on their cell phones, but there are some very simple tools and
practices you should adopt as you become digitally literate.

Tools you should be using 
Vanity searching: If you’re in a position to hire others, you have almost certainly
added Google and Yahoo! to the screening process. Conducting a Web search of a
prospective job candidate is a common step in the early sorting process and the
results can be revealing. A 2006 survey conducted by CareerBuilder found that, of
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hiring managers who used Web searches to research job candidates, 51 percent
have eliminated a candidate based on what they found. If they searched a social
networking site like MySpace or Facebook, the results were more ominous: 63 
percent did not hire the person based on what they found.1

What does this mean for you? Before you apply for a new job, do some vanity
searching in both Google and Yahoo! Make sure there aren’t any compromising
photos or inappropriate material. And if you’re a recent college grad, better check
MySpace and Facebook, too. Just because you’ve never posted a picture of some
wild times at a party doesn’t mean that no one else has. (If you find something,
hopefully you can contact the “friend” who posted it and ask that it be removed.)

Flash drives and memory cards: Remember floppy disks? You probably have a
stack of them at home or work, yet you never use them anymore. That’s because
they hold such a small amount of data — 1.4MB — that they’re just not practi-
cal. Think about it this way: A floppy disk could hold one, maybe two, digital
photos.

Today’s digital landscape relies on small devices with huge amounts of storage.
USB flash drives (for text) and memory cards like compact flash (CF) or secure
digital (SD) (for digital photos or added game memory) can store hundreds or
thousands of megabytes. And,
like most technology, the prices
on these devices have dropped
precipitously since they hit the
mainstream. A 1GB flash drive
cost as much as $100 in 2004.
In 2006, the same drive cost as
little as $19. As a result, as
many as 150 million flash drives
were expected to be sold in
2006.

What does this mean for you? If you work with text, you can feasibly back up all
your documents on a flash drive every time you log off your computer. It’s quick
and easy and, as the saying goes, there are two kinds of computer users: Those
who back up their data, and those who will.

Another useful application for flash drives is the transfer of large files. If you
have photos or a honkin’ PDF that you want to send to someone in the newsroom,
give the e-mail server a rest and copy it to a flash drive. The recipient can down-
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load it in a few seconds and your IT department will thank you for not clogging
the server with several MBs of an attachment.

Flash drives have a bright future, too. In September 2006, the USB Flash Drive
Alliance announced it will endorse a new generation of “smart” drives that will
allow users to run active programs from flash drives. So in addition to document
and image storage, the new flash drives will have your Web browser with all your
bookmarks, your instant messaging program with all your buddies, your games and
more, all encrypted to keep it safe. So wherever you are in the world, you could
use any computer and it would be just like using the one at your home or office.

Mobile 2.0
Now that you understand a little more about Web 2.0 — and you’re reading about
Journalism 2.0 — it’s time to introduce Mobile 2.0. 

The next generation of wireless connectivity to mobile phones will allow regular
cell phones, smart phones, BlackBerries and other devices to connect to the
Internet via a high-speed network. Data will transfer as much as 10 times faster,
according to some reports, which will make video, music, games and e-mail con-
venient to anyone, anywhere.

In effect, this is like going from a dial-up Internet connection to a high-speed
hookup like the one you have at work. 

Even before the third generation (commonly referred to as 3G) saturates the mar-
ket, mobile delivery is a great opportunity for local publishers and broadcasters.
Calendar listings, sports scores, news and weather updates are all within the 
regular operation of most local news publishing operations. Delivering them to
mobile phones and other portable devices is the next logical step.

Look at the market: There are 200 million mobile phone users in the U.S. and 
70 percent are Web-enabled; 35 percent of those who have the Web option are
“regular” users.

• The Weather Channel has 4.8 million paying subscribers a month for its mobile
service.

• ABC/Disney has 2 million subscribers at $15 a month delivering ring tones,
voice tones, wallpapers and video clips. 
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You should be aware that dozens of companies are working hard to make what is
happening now obsolete, so to preview the promise of any of these technologies
would be like predicting the future. Some of these new technologies will gain crit-
ical mass and change the world of communications, but, if I knew which ones, I
would be a venture capitalist instead of a journalist.

What does this mean for you? The push for immediacy will continue as news
operations master breaking news on a Web site and move to present breaking
news on mobile devices. It also means a broadening of the scope of information
that will be considered worthy of an immediate update, meaning all types of
information and news (sports, business, entertainment) will be part of the mobile
equation.

iPod: The slim, sleek, 800-pound gorilla
One gadget that has already changed the media land-
scape is the Apple iPod. By describing the capabilities
and uses of the iPod here, I mean to include any of
the MP3 players on the market with video capability.
No other device has changed the media landscape like
Apple’s player and iTunes stores.

As of November 2006, Apple had sold nearly 60 mil-
lion iPods in the five-year life of the gadget, with 36
million sales in the past 12 months. According to
Piper Jaffray & Co. research released in October 2006,
the iPod owns 79 percent of the market share for digital media players. 

And talk about a youth market. Other Piper Jaffray research on teenagers found
that 72 percent own an MP3 player and 79 percent of those specifically own an
iPod. Almost half of the 1,000 students surveyed expect to buy a new media player
within a year, and 76 percent of those prefer the iPod.

Some mainstream media companies are responding to this growing market. In
September 2006, ABC News began creating a daily 15-minute newscast, separate
from “ABC World News,” frequently using the same anchor, Charles Gibson. The
“World News Webcast” is available through the Web site at 3 p.m. ET and ready to
download on iTunes about an hour later. There were more than 5 million down-
loads in both September and October, 2006.
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Newspapers such as the Roanoke Times in Virginia and the Naples Daily News in
Florida began “vodcasting” in 2006. Each paper has built a studio for recording
and producing video segments and each is making those shows available for
download to an iPod or viewable on the Web site.

National Public Radio, meanwhile, serves more than 6 million downloads of its
podcasts each month.

What does this mean for you? Every news organization is likely to try adding
video to its mix very soon (if it hasn’t already). If you can be an early adopter
and find a way to incorporate video into your beat or your specialty, you will have
a leg up on the competition. 

‘Other’ wireless 
Some people actually still connect to the wireless Internet with a laptop computer.
OK, that’s being too flip, since laptops are still the primary vehicle for people to
use with the Internet, but when you see what’s happening with iPods and cell
phones, it’s easy to forget.

Hitting a coffee shop with your laptop and paying a few bucks to connect to the
Internet is one of the most popular ways to work wirelessly these days. But that
business model doesn’t look promising. Independent coffee shops, restaurants, car
dealers, rock-climbing gyms and all sorts of other small businesses now offer free
Wi-Fi access, too. And the field is only getting more crowded.

• Many cities are working on municipal Wi-Fi systems to bring free wireless
Internet access to a concentrated area like a downtown. 

• Special cards provided by the major cell phone companies insert into most lap-
tops and allow wireless connection to the Internet from anywhere there’s cell
phone coverage. Users pay for the card — usually less than $100 — then pay
a monthly service fee for unlimited connectivity. A new service, called EV-DO,
offers broadband-like speeds. 

• A company called Clearwire, founded by Craig McCaw, who built one of the first
cell phone companies, is launching in several U.S. cities. It offers standard
wireless service or a special modem-like device that can be plugged into a lap-
top or desktop computer for more reliable service at a higher speed. The idea
is that you could pay for one service that would go with you anywhere, so
Clearwire would be your provider at home, at the local coffee shop, or wherever.
You would use this external modem to connect at home or take it into coffee
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shop and use it instead of paying six bucks for a T-Mobile hook-up. It’s like
having your home Internet connection anywhere.

What does this mean for you? The online audience served by breaking-news
updates throughout the day will continue to grow. Thought of as the “at-work”
audience for much of the digital age, potential readers of news updates will grow
as wireless Internet service becomes free and ubiquitous. Combined with Mobile
2.0 gadgets and services and the continued mainstream adoption of downloaded
material on iPods, the opportunities for news companies to reach customers digi-
tally will continue to explode.

Get your “mojo” on: The increasing adoption of mobile communication technolo-
gy not only changes the way audiences receive the news, but also opens up new
ways to report it. Mobile journalists — or “mojos” — are becoming more common
at TV news stations and even popping up at newspapers. Also known as backpack
journalists, these multidimensional dynamos can carry an assortment of tools into
the field to report the news in a fully multimedia manner. A
laptop with wireless Internet connection, a video camera
(that also shoots still photos) and an audio recorder are the
basic pieces of equipment that allow journalists to produce
news stories or blog posts, photos, video, or audio for a
story.

Yahoo!’s Kevin Sites is the best-known backpack journalist
working today. Sites traveled to war-torn countries around
the world to tell the stories of those most affected by
calamity, and his regular feature, In The Hot Zone, on
Yahoo! News claimed 2 million readers a week in 2006.

The News-Press in Fort Myers, Fla., meanwhile, dispatched several “mojos” into
the field every day to report hyperlocal news close to home. These new era
reporters have no desks and rarely a specific assignment outside of a geographical
area to visit. They drive around their area and perform a modern version of that
“old shoe leather reporting.” They also do marketing, handing out fliers to edu-
cate people about the news organization’s online services.

Frank Ahrens of The Washington Post profiled the News-
Press mojos in December 2006 (and shot this photo of
Kevin Myron in his car). “Their guiding principle: A con-
stantly updated stream of intensely local, fresh Web con-
tent — regardless of its traditional news value — is key 
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to building online and newspaper readership.”

Mojos are still an experiment, but if nothing else, they show how flexible — and
mobile — journalists in the future can be when it comes to covering and reporting
news.

Assignment:
1. Talk to others about their toys: Ask how they use their cell phones, their

iPods, and their wireless Internet. Ask them if they know people who use
these technologies in interesting ways. To understand this new world, you
should be able to converse in it.

2. See what you can do: Have you tried to get news on your mobile phone?
Have you downloaded a podcast to your computer or MP3 player? Try it.

1 CareerBuilder.com Industry Trends, 2006 Surveys: “One in four hiring managers have used Internet
search engines to screen job candidates,” Oct. 26, 2006. http://www.careerbuilder.com/Share/
AboutUs/IndustryTrends.aspx?archiveyear=2006
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Chapter 4:

New Reporting Methods

Reporters, editors and photographers all store data digitally. Even if it’s just

your list of contacts, learn to manage your data electronically to maximize its

usefulness in the future. And open up your reporting to harness the power of

the public.

Introduction
Phil Meyer began his 1991 book, “The New Precision Journalism,” an updated 
version of his seminal work introducing reporters to social science methods, with
an observation that seems even more prescient today: “If you are a journalist, or
thinking of becoming one, you may have already noticed this: They are raising the
ante on what it takes to be a journalist.” 1

While the ante is being raised, resources seem to be evaporating. Decreasing cir-
culation and advertising revenues are leading management to ask more and more
from their reporting and editing staffs. How do you deliver more? Embrace tech-
nology and use the power of the people to help with your reporting legwork. It
makes newsgathering much more efficient if you can jumpstart the process of
finding background, data, sources and experts.

To meet the increasing demands of editors, reporters need to become as efficient
as possible. Through the use of technology and a more open approach to gather-
ing information, reporters, photographers and editors can leverage their talent for
newsgathering and news judgment without sacrificing their values. Capturing key-
strokes to build useful databases (calendars, births, deaths, scores) and using new
reporting methods such as crowdsourcing and distributed reporting are becoming
the focus for more and more U.S. newsrooms.

Chapter  4: New Reporting Methods
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Journalists are generally suspicious of new reporting methods. OK, this is actually
one of the slowest professions to embrace change. A few decades ago, reporters
were unsure about using quotes in a news story that came over the telephone,
that newfangled gadget. In the 1990s, the same reservations surfaced when
reporters began using e-mail. Today, despite the advances being made on news
Web sites, there remains a general disdain for the new medium by many “tradi-
tional” journalists and a longing for the good old days before a fragmented media
landscape made the job of capturing the audience’s attention so demanding.

Today, everything from blogs to
reader comments on a news Web
site are sparking debate and
causing traditionalists to sound
many warnings. But if you cut
through the rhetoric you’ll find
unprecedented opportunities to
do better journalism by embrac-
ing technology and trans-
parency — two essential 
qualities for amplifying the
important work of journalism 
in the digital age. 

Spreadsheets and storing data
If you are a reporter and you don’t think you’re quite ready for blogging, RSS
feeds, audio and video, you should apply the power of technology to your current
endeavors. In short, you can become a better, more efficient reporter or editor
simply by trading some of the paper-based information storage systems you’re
currently using and going digital.

Stop using paper: If you are still using a Rolodex with little white cards to keep
your contact list — STOP! This antiquated method is robbing you of precious time
whenever you need to access a contact and is preventing you from storing more
pertinent data on each of your contacts. Learn to use the contacts function in
your e-mail program (Outlook or Entourage, for example) or, better yet, a spread-
sheet program like Excel or Google’s free program (http://docs.google.com/).
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opportunities to do
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embracing technology.



Fielded data is a beautiful thing: When you set up a spreadsheet to compile
lists (such as contacts), always try to include as many fields as possible. Fielded
data is the key to sorting efficiently and being able to group items. 

Mike Sando, the National Football League reporter at The News Tribune in Tacoma,
Wash., uses fielded data as well as anyone. He tracks every stat of every game he
covers in Excel and then sorts the data to answer virtually any question, and
posts the results on his blog. For example, below is an analysis of the Seattle
Seahawks’ performance on third down at one point during the 2006 season.

Sando sits with dozens of football writers each week who cover the same games
he does. While they use pen and paper and elaborate grids to track the game’s
proceedings (or worse, rely on the teams’ media handouts), Sando builds spread-
sheets (on his laptop computer) with important data as each play occurs. His 
colleagues, meanwhile, are creating a temporary resource that will help them
write a game story but will be of little use as the season progresses.

43
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e

More examples: For other kinds of sample data files that might be useful in

news reporting, go to http://powerreporting.com/files/index.html.



Chapter  4: New Reporting Methods

Here’s how another example of data collection, sorted into a fielded spreadsheet,
becomes a powerful display of information. This one charts grocery prices in
Chicago suburbs.

Where data can thrive: Some newspapers are making their Web sites “data desti-
nations,” and well they should. Computer-assisted reporting has been around for
decades but, restricted to the newspaper format, it can’t realize its full potential.
On the Web it can sing, with depth, customization, searchability and a long shelf-
life. USA Today realized this years ago when it began loading the salaries of 
professional baseball, football, basketball and hockey players into searchable
databases (www.usatoday.com/sports/salaries/index.htm). Other newspapers, 
such as the Louisville Courier-Journal, collect their databases in one area on their
Web sites (www.courierjournal.com/apps/pbcs.dll/section?category=data).
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Your ‘so-called digital life’
If your company doesn’t provide a slick, simple-to-use tool for capturing notes,
lists and calendar items, use a free Web service like Backpack (backpackit.com).
This will enable you to manage your time by adding meetings and appointments
to a calendar while simultaneously managing a to-do list. You can access it from
anywhere via the Web and even share it with others in your newsroom. An elec-
tronic system like this is better than paper because it’s easy to edit and modify
lists, change the order or priority, and store your calendar items and lists as an
archive.

If you can, use a database: At the Ventura County Star, Howard Owens built a
database for news sources and set it up so that all the reporters could share it
over the Web. “All source information was stored there and was accessible by the
entire newsroom,” Owens said.

Many newsrooms have set up similar databases, but not enough of them. Ideally,
it would store a source name and contact information, background information
and the file name and location of a mug shot if one exists. It should contain per-
sonal information such as birthday (for age purposes), spouse, children, title and
affiliation. Affiliations (school, business, agency) can be stored in a separate
table so they could be entered once and related to a source. Then anyone in the
newsroom can search by name, specialty or agency.

As more journalists go digital it will make it easier to share information. Derek
Willis of The Washington Post wrote in the first of his series of essays on his blog
“humbly titled Fixing Journalism”: “Can you imagine another information-based
business that permitted its employees to build walls around their information? Can
you imagine it succeeding today?” (Read the entire series at www.thescoop.org/
thefix.)

Think of all the information that passes through a news organization every day.
Now think how little of it is accessible to those who work there, or more impor-
tantly, to the public who would like to access it. This is a problem for news
organizations going forward. And it needs to be fixed now. You can start by 
storing your information electronically and pushing for data-sharing tools like
internal wikis and shared databases.

Event calendars are the obvious place to start in your newsroom. If staffers are
still entering each event by typing it into a Word document, you have a problem.
If you had a database, such information as venue name, address and phone num-
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ber would only have to be entered once, thereby cutting the workload (and the
chance for typos).

There are many other opportunities where keystroking is being repeated year after
year in flat files that aren’t searchable or sortable by the audience. Here’s a few
areas we’re databasing (or planning to) in Tacoma: 

• Summer camps lists.
• Sports team tryouts and camps.
• Restaurant and movie listings.
• Vital statistics (births, deaths, divorces).
• New businesses and business hires and promotions.
• Hike of the week.
• Guide to local ski areas.

Each of these types of content has been entered by newsroom staff for years, if
not decades. We can maximize the value of the data by providing it to our audi-
ence in a database format while streamlining our own operation and cutting down
on the amount of data entry we do. 

Can you database news coverage? Yes, you can. Many newspapers have adopted
the “alternate story form” for basic news coverage,
where a narrative is broken apart into easily digestible
chunks with labels like “what happened,” “what it
means” and “what’s next.” The Oregonian in Portland
has standardized its meeting and process coverage
with “update boxes.” This new story form, with labels
like “At Stake,” “Update,” “What’s Next,” and “Learn
More,” means the data is already being published in
consistent fields that could be easily converted to a
database.

Think of city council or school board meeting cover-
age. If you had a database that stored all the perti-
nent data (date of the meeting, top agenda items
with a quick summary for each, the votes and maybe a
field for analysis) you could pull from this to populate
such an alternative story form for the print edition.
Online, the audience (and your reporters) would be
able to search and sort previous meetings. 
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An example of an Update
Box from The Oregonian.



Crowdsourcing
As discussed in Chapter 2, the concept of Web 2.0 sees the Internet as allowing
enthusiastic communities to come together and provide more value for a given
Web site. Crowdsourcing focuses that community power on a specific project and
demonstrates how a large group of committed individuals can outperform a small
group of experienced (and paid) professionals. The online version of Encyclopedia
Britannica, for example, cannot keep up with Wikipedia in terms of updating arti-
cles and information. And Microsoft, with all its resources, has struggled to keep
pace with the development of the Firefox browser, a project powered by volun-
teers collaborating together under the nonprofit Mozilla Foundation.

Crowdsourcing is a relatively new term, coined by Jeff Howe in a 2006 article for
Wired News.2 It is very similar to “distributed,” “collaborative” or “open-source”
reporting and many people use the terms interchangeably. To distinguish between
the concepts, think of crowdsourcing like outsourcing, the term from which it 
was born. The focus of crowdsourcing is usually ongoing production of information
while distributed reporting relates more closely to a specific and fixed-time proj-
ect, such as answering a specific question or reporting on a specific subject.
Voting irregularities, then, would be a form of distributed reporting since the
need would be reporting for a timely news story. 

But don’t get frustrated by the terminology. This is all very fluid and rapidly
developing. It’s the concepts that are important.

In the summer of 2006, The News-Press in Fort Myers, Fla., asked for readers to help
in the investigation of ongoing concerns over rising utility bills. The audience
responded in surprising numbers and supplied the reporting that became the story.
The newspaper was caught off guard by the initial flood of calls and e-mails. 

“The story built itself,” News-Press editor Kate Marymont said. “The public shaped
it and we had to get used to that. We had to learn that online development of a
story and the development of a print story take different paths.”

Crowdsourcing harnesses the power of community on a continuing basis to
improve a service or information base. When we built an online map plotting all
the places in our coverage area to go for free wireless Internet access, The News
Tribune then asked the public to submit locations that we missed or that have
since opened. We also invited them to comment on the locations and add photos,
enhancing the original service. In the first six months, dozens of readers have
contributed.
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The concept of crowdsourcing might seem to lend itself especially well to grass-
roots organizations and projects. But some of the most notable examples of
crowdsourcing have come from some very big companies, including Procter &
Gamble, Amazon and Google. Following are some examples:

• Procter & Gamble launched a Web site called InnoCentive offering serious cash
rewards to more than 90,000 freelance scientists who could solve problems
that the company’s 9,000 scientists couldn’t. It now works with other compa-
nies as a sort of crowdsourcing broker, allowing them to use the site to solve
problems of their own. www.innocentive.com

• Amazon.com describes its Mechanical Turk project as “Artificial Artificial
Intelligence.” It pays people to complete tasks that people do better than
computers, such as identifying subjects in photographs and translating text.
This is the opposite of the InnoCentive project. The pay is low and the tasks
can be done by anyone. People need to perform a high volume of tasks to
make any real money, but the tasks are so simple that some 10,000 people
have registered to “turk.” www.mturk.com

• Google doesn’t pay people to participate in its Image Labeler program, but it
made the exercise so fun that it can be addicting. The goal is to improve the
quality of Google’s Image search. Over a 90-second period, you are shown ran-
dom images and asked to provide as many labels as possible. You “play” with
another random user and when the two of you agree on a label, the software
gets smarter. http://images.google.com/imagelabeler/

Distributed, collaborative or open-source reporting
The concept of distributed reporting is a form of transparency for a news organi-
zation. Traditionally, readers only learn about stories a news organization is work-
ing on when the articles are finished and published. While it is customary to keep
a story idea secret to prevent the competition from running with the idea, the
distributed reporting model requires a news organization to go public with a story
idea early in the reporting process. 

The reason? To allow readers to assist in the reporting of the story. 

In December 2006, The Cincinnati Enquirer tapped the power of distributed
reporting to gauge compliance with a new smoking ban. Here’s how the paper’s
investigative and enterprise reporter, Gregory Korte, described it in his blog: 

48
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e



“Whether you’re a smoker or non-smoker, you probably want to know which bars,
restaurants and bowling alleys are complying with Ohio’s new ban on smoking —
and which are ignoring it until the state posts new regulations. 

And we’d like to tell you. But with 1,488 bars and restaurants in Hamilton County
alone (that’s just counting the liquor licenses), it’s hard to get around to all of them.

It’s a good example of why The Enquirer, like all Gannett newspapers, is embarking
on an experiment in what we call ‘crowdsourcing.’ We’re asking you to help us report
the story by telling us what’s going on in all those places we can’t get to.”

While the terms used to describe it are new, the practice itself has been around
for many years. The Spokesman-Review in Spokane, Wash., began using distrib-
uted reporting in 2001 with a database of e-mail addresses — something it called
a “reader network” — to correspond with readers while reporting stories. This
model has been copied by newspapers everywhere and used effectively in many
situations, especially when looking for sources to interview on a specific topic or
feedback or reaction to a current issue in the news. 

Most reader networks were started with e-mail addresses from readers who had
contacted the newspaper, either by sending a letter to the editor or asking a
reporter about a news story. Through its Web site, a news organization can also
build the database by advertising the network and inviting readers to join.
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During the 2006
Elections, The Cincinnati
Enquirer invited readers
to report voting prob-
lems they experienced
at their polling places.
Dozens of readers called
or e-mailed to describe
the irregularities and
The Enquirer presented
the problems on a
Google Map on its Web
site (http://www.cincin
natidatadesk.com/pages
/voter.html).
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Minnesota Public Radio excels at this with its Public Insight Journalism initiative
(http://minnesota.publicradio.org/your_voice/). By collecting as much informa-
tion as possible, the news organization can slice the network several different
ways and target specific subsets of the list for certain queries. People who live in
a particular ZIP code, for example, or sports fans. 

Ken Sands, who pio-
neered the practice 
in Spokane, highlights
two ways the use of an
e-mail network differs
from traditional audience
feedback such as letters
to the editor or person-
on-the-street interviews.

“One, the interaction
occurs before publica-
tion, during the informa-
tion-gathering process;
and, two, by actively
reaching out to people,
you get a different,
broader reaction than
you do by waiting for
people who are compelled by passion to contact you,” Sands wrote for the Knight
Citizen News Network (www.kcnn.org). 

Some newspapers now have more than one reader network. It can make sense to
create and manage separate contact databases for education stories (if you need
direct contact to teachers) or business stories (if you need to get feedback from
local business leaders only). 

The concept is going national (and/or global) too. In 2006, New York University
professor Jay Rosen and others launched NewAssignment.net, a sort of clearing-
house for open-source reporting projects produced by teams of volunteers. Craig
Newmark (of craigslist fame) contributed $10,000 to help launch the project. 

“In this sense it’s not like donating to your local NPR station, because your local
NPR station says, ‘Thank you very much, our professionals will take it from here.’
And they do that very well,” Rosen wrote on his blog PressThink. “NewAssignment
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says: Here’s the story so far. We’ve collected a lot of good information. Add your
knowledge and make it better. Add money and make it happen. Work with us if
you know things we don’t.”

At a time when news organizations are looking for ways to build brand loyalty,
getting readers and viewers to participate in the news process can help. 

Summary
As you probably are painfully aware, very few, if any, news organizations are
adding to their staffing levels these days. That doesn’t mean that journalism is
any less important than it used to be. It means that journalists need to find new
tools and efficiencies to continue their important work and even take it to a
higher level.

“We need to get out of the keystroke business,” says Don Nelson, executive editor
of the Skagit Valley Herald in Mount Vernon, Wash. 

You need to leverage existing resources. Storing data electronically is a good place
to start. Finding ways to incorporate crowdsourcing in your reporting will help, too.

Assignment:
1. Convert your contacts to an electronic form.

2. Ask a managing editor about a shared newsroom database for contacts.

3. Identify a story you’ve done, or one you’ve read recently, that would have 
benefited from crowdsourcing or distributed reporting.

1 Philip Meyer, The New Precision Journalism, 2nd Ed., Indiana University Press, 1991. Philip Meyer is
the Knight Chair in Journalism at the University of North Carolina at Chapel Hill. This is an updated
version of Meyer's 1973 book, “Precision Journalism: A Reporter's Introduction to Social Science
Methods.”

2 Jeff Howe, "The Rise of Crowdsourcing," Wired Magazine, June 2006. Jeff Howe covers the entertain-
ment industry as a contributing editor for Wired Magazine.
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Chapter 5:

How to Blog

What makes a good blog? And a popular one? Some basic principles, similar to

those that make good news stories, can be applied to help any rookie blogger

cultivate a community online.

Introduction
Kevin Cullen, a projects reporter for The Boston Globe, was introduced to the
practice of blogging during the 2006 World Cup as a U.S. correspondent for the
Goethe-Institut. Simultaneously he was filing for The Globe’s sports desk. 

“The next day, I compared my words that had gotten into the paper with what I
wrote for the blog,” Cullen wrote in the December 2006 issue of Nieman Reports.
“The blog entry seemed better than the newspaper story. It wasn’t much longer,
maybe by 300 to 400 words, but those extra words contained some good quotes,
some stylistic segues, and a little more color. It was, without a doubt, a better
read. Unencumbered by the need to squeeze words into a finite space, the Internet
proved better for me, as the writer, and I’d argue for readers, too, than newsprint.”

Many new media analysts have suggested that every reporter should have a blog.
That may not be feasible (or sensible), but scores of successful journalist blogs
are currently online, allowing the blogger/reporter to cultivate a community 
with readers to test ideas, receive early and direct feedback and publish in the
timeliest manner possible. 

A good blog helps a blogger/reporter enhance his or her authority on a beat by
adding the ability to publish information outside of the traditional news cycle and
story format. It also helps the news organization establish a deeper relationship
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with readers and leverages the wisdom of the crowd for the benefit of the
reporter’s coverage.

“Readers are our friends,” says Ben Mutzabaugh, who blogs about business travel
for USA Today, when asked what he has learned as a blogger for the past five
years. “In print it’s easy to feel you are at odds with readers because people will
find one little thing wrong. So as a journalist you get defensive. The readers on a
blog chime in and help you. They want you to get the story right. … Readers help
make the blog stronger than any single author could make it alone.”

The rules are different with a blog. You can play off other information you find
online, even linking to
stories and blogs that
might be thought of as
“competition” but, in
reality, are essentially
all part of the virtual
community conversa-
tion on a given topic.

A 2006 study by the
Bivings Group found
that 80 of the top 100
daily newspapers in the
U.S. have at least one
reporter blog on their
Web sites. On 67 of these blogs, readers can add their own comments.1

Simply launching a blog is not good enough, however. Bob Cauthorn, a former
editor at the San Francisco Chronicle, once noted the challenge for reporter blogs:
“I think it's going to be difficult for newspapers to do blogs right because their
DNA continues to be trapped in the ‘we talk, you listen’ mode.” 

A good blog is an ongoing conversation. It is facilitated by you, but, if it works,
it may be dominated by your audience. If that happens, you win, the news organ-
ization wins and, most importantly, the readers win.
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What is a blog?
I hate the term “blog.” It doesn’t sound the least bit revolutionary, technological-
ly savvy or cutting-edge. But that’s exactly what blogs are. 

Blogs have changed forever the way information is disseminated in our society.
They’re fast. They’re interactive. They’re freewheeling. They can be dangerous.
They are already powerful and growing more so every day.

Blogs usually have several common characteristics: 

1. A frequently updated online journal, written in a conversational style, with
entries displayed in reverse chronological order (most recent stuff on top).

2. Links to other news and information found on the Web complemented with
analysis from the blogger (or bloggers).

3. A “comments” link that allows readers to post their own thoughts on what the
blogger is writing about. Not all blogs allow comments, but most do.

How did blogging become a phenomenon?

In the first information revolution in the 1990s, everyone started creating Web
sites just to have one. The advent of blogs has paved the way for a more authen-
tic information revolution.

The Internet of the 1990s was said to allow “anyone” to become a publisher. But
it turned out that “anyone” needed to know a little bit about computers and,
specifically, how to build a Web page. As a result, individual publishers were

largely computer code jockeys
and graphic artists and designers
who were much more interested
in pushing the cosmetic limits of
this new medium. In essence, it
was style over substance. Lots of
flashy Web sites were built, but
once you visited them, there
often was little reason to return.

Blogs flipped this model on its
head. They’re not always pretty
to look at, but they can be
“published” by anyone who can
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click a mouse and type. The software makes it so easy to publish, in fact, that
blogs can be updated several times a day with about the same effort as sending
e-mail. 

It was an effective way for citizens of all stripes to discuss the aftermath of the
terrorist attacks in 2001. The energy created by those post-9/11 blogs morphed
into passionate discussion and debate leading up to the military action in Iraq,
then evolved in 2004 as election season shifted into high gear. Presidential candi-
dates and the Republican and Democratic national committees hosted blogs, alter-
ing the perception of a blog as a grassroots communication tool and furthering
the mainstreaming of the medium. 

Getting started
Before you wrote your first news story, you read other news stories. Knowing the
form of the medium is essential to understanding the fundamental components,
such as the lead,
the nut graph and
the walk-off. So it
is with blogs.

You should read
blogs in order to
write an effective
blog. Finding the
right ones to read
will take a little
searching, but is
worth the time.
Start by scanning
the A-list bloggers
on the top 100 at
Technorati.com.
Then visit other
newspapers whose journalism you respect and check out their blogs. Then find
blogs that cover the same subject matter as your beat and make a regular habit of
checking them for updates. (You should be doing this whether you have your own
blog or not, and now you can subscribe to them via RSS.)
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As you read other blogs, both journalists’ blogs and independent blogs:

• Notice which posts you like the most, then distill: What makes it compelling? 
• Note ways you could incorporate the best elements that you find. 
• Track the frequency of posts. Does the blog update as often as you like? Or too

often? Is there too much material to keep up with?

Terminology
OK, time for a little vocabulary. There are some new terms bloggers use to describe
the mechanics of the medium and it’s important to know what they mean.

Post: An entry on a blog or, as a verb, to make an entry on a blog.

Permalink: A link available on each post that allows direct access to that post,
usually with comments visible. This helps other bloggers link directly to a given
post and helps readers e-mail a link to a specific post to friends.

Trackback: A mechanism for communication between blogs, allowing one blogger
to let another know that he or she is linking to their material. This helps readers
easily follow a conversation and helps bloggers know who is linking to each 
post. A pingback performs essentially the same function with slightly different
technology. Trackbacks have fallen out of favor with some bloggers because they
are susceptible to spam.

Blogroll: A collection of links usually found on the sidebar of a blog, it is
designed to inform the blog’s readers of the sites the blogger frequently visits.
The thinking goes: If you like my blog, then you’ll probably like other blogs I
read. The links in a blogroll are most commonly other blogs but can be general or
news Web sites, too.

Linkblog: A blog comprised of links to other online sources with little or no 
original commentary.

Vlog: A blog that features video commentary as its primary medium, as in “video
blog.”

Moblog: Blogging from a mobile device, as in “mobile blog.”
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Mechanics
While trained reporters have a built-in advantage with their experience in
research, reporting and distilling facts and information, they are at a disadvan-
tage when it comes to forming blog posts. Too many years of writing inverted 
pyramids and anecdotal leads bog down many a journalist-blogger’s posts. The
goal in blogging is to write tight and be quick: Get to your point immediately 
and get out of there. You’ve got a story to file for print, after all.

Think e-mail: One way to get your mind around the idea of blogging is to think
of it as an e-mail to someone you know. They know you’re “in the know” on this
subject so you don’t have to work to prove your worth. You can be economical
with your words but much more conversational than you’d be in a news story.
Think about that long-winded e-mail you receive — that’s exactly what you’re 
trying to avoid. 

Link, summarize and analyze: Attribution is, of course, important in a blog and
it takes the form of links. A great post is sprinkled with links to other sites, news
articles and even other blogs. Posts should vary in length but always be direct
and to the point. 

Be specific with headlines: A tendency for rookie bloggers is to be extra flippant
with their writing once they have a blog, especially in the titles they use for their
posts. Avoid this. A good blog headline — just like a good newspaper headline —
previews the information the blog post will contain and does it in a compelling
manner.

Be the authority — with a personality: The narrower the topic, the better. Not
only will your audience clearly understand the subject matter covered, the blogger
will have a better chance to present his or herself as the best source of timely
information on that particular topic. And that’s the goal, after all: To combine
authority with personality.

Frequency and handling comments
Be short with your posts: For your most loyal readers, you are the “middle man”
between them and the sources of information they’re trying to follow. Anything
you can do to connect readers directly to the source will build credibility for you
and make your readers want to return to your blog. If you find a report online
that will be the focus of an upcoming story, link to it with a blog post and simply
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say, “This is interest-
ing. I’ll be writing
about this soon.” And
be done with it.

Mike Sando, the beat
reporter for the
Seattle Seahawks at
The News Tribune who
won a 2006 award
from Editor &
Publisher for the best
sports blog in the
country, has perfected
this technique. As soon as he leaves a press conference, he uploads the entire
audio to his blog, allowing his readers immediate access to his source material.
Then he follows up later with his analysis and then files a story for the next day’s
paper (http://blogs.thenewstribune.com/seahawks/).

Post at least once a day: If you can be short with your posts, you can easily add
at least one every day. That’s an important minimum to hit if you plan to build an
audience. Ideally, you will post even more frequently. After all, if your beat is
worth covering, there should be enough action to support this frequency. 

“I’m too busy!” Sure, we all are. But successful journalist-bloggers have found
ways to make the blog work for them, saving them time instead of simply becom-
ing an added time burden.
You can use the blog as a
notebook, compiling your
notes and story ideas. It can
help organize your thoughts.
And if you build an audience,
the leads and feedback you
receive will forever change
the way you approach your
beat.

“A big innovation for me is
the blog, though I promised
that I would stop using the
term,” said John Cook, who
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John Cook's Venture Blog covers venture capital
and technology companies.



writes about technology companies and venture capital for the Seattle Post-
Intelligencer. “One reason is that I think the term ‘blog’ confuses people. For me,
it is simply an online publishing vehicle that I can use to cover my beat better.

“I now devote most of my time to the blog, partly because that is where my audi-
ence is. It has radically changed my job. I cover my beat — start-ups and venture
capital in Seattle — more aggressively than I ever have. Part of the reason is that
I have the flexibility to publish when and where I want without the concerns of
whether the story would make it in the print edition.”

Handling comments: First, you should not start a blog unless you’re willing to allow
comments. Some mainstream news blogs don’t allow comments, severely undermining
the medium’s community-building function. (This might be a decision made above
your pay grade that you can’t do anything about. But you should try.)

Second, you should embrace comments as a valuable reporting tool and not dis-
dain them as many traditional journalists do.

You can cultivate comments by adding your own comments to any discussion that
needs clarification, redi-
rection or simply a vote
of confidence. For exam-
ple: “Great comments,
everyone. Keep them
coming!” You can high-
light astute observations
or pertinent questions by
turning them into full
blog posts. This will give
you easy blog fodder and
give your readers the
sense they matter to
you. That’s important
because one of the reasons blogs are popular is that they embrace interactivity
and give readers a sense of participation. 

“When comments started landing on my blog, it dawned on me, ‘I can talk to
these people,’” said Greg Reeves, who covers courts, police and special assign-
ments, and does database and computer-assisted reporting for The Kansas City
Star, where he started the Crime Scene KC blog in 2005 (http://blogs.kansas
city.com/crime_scene/).
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“The interactivity was
eye-opening. I was
finally learning what
people care about and
what they don’t care
about. Now I’m getting
300 to 500 comments a
day, and online commu-
nities are forming in
the blog.” 

Comments can be like
gold, but they can also
tar and feather your
blog. Don’t let a few
bad apples ruin the con-
versation for everyone else. Rule the comments with a strict focus to staying on
topic and maintaining respectful discourse. If it works, the comments will feel like
a good pub on a Friday night with a rolling conversation. But sometimes people
get out of hand and deserve to get thrown out. 

Using photos and screenshots
Would you read a newspaper or magazine that had no pictures, graphics or art of any
kind? Of course not. So don’t expect readers to flock to a boring blog without art.

If you work for a newspaper or magazine, you have access to a treasure trove of
images. And as a reporter/blogger, you will likely be covering subjects that have
been covered previously, so reusing file photos should be easy.

Most blogging software makes adding a photo to a post as simple as adding an
attachment to an e-mail. Some systems will even resize the photo so you don’t
have to. If not, and you pull a high-resolution image from the archives and need
to size it down to save your page-load time (big pictures make Web pages very
slow to load), use an online service like Snipshot to quickly resize an image with-
out downloading and learning new software. (See Chapter 8 for more information
on handling digital photos.)
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Love it or leave it
Most people got into journalism because they liked it first, then found they had a
talent for it. The same recipe will work on the blogosphere, too. 

If you are considering a blog, do it for the right reasons. If it’s an assignment
from a managing or executive editor, or it’s something you just feel obligated to
do — don’t. You need to be passionate about your blog — just as you are pas-
sionate about your craft or your beat. If you’re not, you’ll be wasting your time.

In our newsroom in Tacoma, we say, “You have to love your blog.” And, while
there is no measurement for blog love, it’s obvious after six months who loves and
who loathes their blog. Mostly we’ve found that reporters, editors and even pho-
tographers — once they get started — wish they had more time to spend on the
blog. For some it becomes the cornerstone for all their work. These reporter/blog-
gers can’t imagine working in a world without a blog, just like no one in journal-
ism today can believe there was a time before e-mail and the Internet.

If you can find the fire to blog, you will reap the rewards. 

Assignment:
Check out these award-winning newspaper blogs (winners of the 2006 
Editor & Publisher EPpy Awards):

News — Crime Scene KC: http://blogs.kansascity.com/crime_scene
Business — Today in the Sky: http://blogs.usatoday.com/sky
Entertainment — MeMo: http://blogs.chron.com/memo
Sports — Seahawks Insider: http://blogs.thenewstribune.com/seahawks

1 "The Use of Internet by America’s Newspapers" study, The Bivings Group, 2006.
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How to Report News 
for the Web

Quick! Your editor needs a few paragraphs for the Web site. What do you do?

This brings panic to many newspaper reporters but writing for the Web is easy

once you see it broken down and understand what readers are seeking.

Introduction
Of all the skills a journalist needs in the digital age, reporting for the Web should
be the easiest to learn. There aren’t any new concepts or new terminology or new
software to master. Just a new way of thinking and working.

The Web site needs breaking news. If you’re a reporter covering a beat, it will pro-
duce breaking news from time to time. It’s your job to supply the home page of
your Web site with that breaking news so be ready to use the multimedia tools
now available to you to report the story immediately. If you’re covering a wreck
on the highway, you may only be able to file an audio report. Or you may need to
dictate to a rewrite person in your newsroom. 

Writing for the Web is similar to wire service reporting, so a newspaper reporter
needs to think less in terms of filing one complete story and more in terms of 
filing in “takes.” The first take may be a headline saying “5 Children Killed in
Highway Bus Accident” — with the skeletal facts in the lead. That is good
enough to tell people what is going on. It’s more in keeping with the broadcast
model and less on the print model. One paragraph and a headline becomes three
paragraphs in 20 minutes, and five paragraphs in 45 minutes. As your reporting
continues, you’ll flesh out the story. The balancing act comes in avoiding any
pressure to write about facts that may be in flux.

Chapter  6: How to Report  News for  the Web
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Timely and relevant: Time is of the essence online. Stories that don’t even make
the newspaper are important online (a bomb threat at a school that eventually
turns out to be a false alarm; a wreck on the interstate that temporarily bottles
up traffic) but only if readers find the stories on their time, when they’re looking
for them. Relevancy is essential, too. If you’re covering an event where news is
expected to happen, write about why and what’s expected and publish it online in
advance.

Write lively and tight: Readers appreciate writers who do not waste their time.
Simple, direct language communicates the information efficiently. Plus, it’s faster
to produce than elegant prose. Here are some tips from Jonathan Dube on the
Poynter Institute’s Web site1:

• “Writing for the Web should be a cross between broadcast and print — tighter
and punchier than print but more literate and detailed than broadcast writing.
Write actively, not passively.” 

• “Good broadcast writing uses primarily tight, simple declarative sentences and
sticks to one idea per sentence. It avoids the long clauses and passive writing
of print. Every expressed idea flows logically into the next. Using these con-
cepts in online writing makes the writing easier to understand and better
holds readers’ attention.” 

• “Strive for lively prose, lean on strong verbs and sharp nouns. Inject your writ-
ing with a distinctive voice to help differentiate it from the multitude of con-
tent on the Web. Use humor. Try writing in a breezy style or with attitude.
Conversational styles work particularly well on the Web. Online audiences are
more accepting of unconventional writing styles.” 

The last paragraph might surprise you, but it’s good advice. The rules for this
game are just now being written. Experimenting and challenging the status quo
are encouraged. Even if the news story will appear as a traditional 25-inch thumb-
sucker in the next day’s paper, the early version online shouldn’t. It needs to be
quick, snappy and (if possible) fun. 

Still, you have a responsibility to the fundamentals of news reporting. Facts need
the same level of checking they get for the print edition. Speed and style are
great, but providing the “why” of the story is still critical. Find that “sweet spot”
in between the “just the facts, ma’am” reporting delivered on most news sites by
the news services and the style-without-substance reporting found on alternative
news sites and blogs.
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This is where mainstream news sites need to focus: Delivering full reportage in a
timely manner with some flair. 

Use time stamps: If you have a developing story that will need updating
throughout the day, simply tack on new information with a timestamp and keep
adding to it. This saves you from having to rewrite the entire thing every hour
when new information is dribbling in.

Here’s an example from the Fresno Bee in California:

Standoff over, suspect deceased

12:47 p.m.: Fresno police confirmed the death of a man who held them at bay for seven
hours after he shot two officers early Thursday.

Capt. Keith Foster said police do not know how the man died and would not confirm his
identity.

Police spokesman Jeff Cardinale said the assailant was found dead in the home. He also
said police did not fire their weapons. 

11:08 a.m.: Fresno Deputy Police Chief Roger Enmark reported that a police officer who
was shot several times has undergone surgery at University Medical Center and is in stable
condition with wounds that are described as not life-threatening. 

The other officer, who was shot once, was treated at UMC and has been released, Enmark said. 

Police are not yet releasing the officers' names. Both are patrol officers who have been
with the department about two years. Police Chief Jerry Dyer is on his way back to Fresno
from a conference of the International Association of Chiefs of Police in Boston and is
expected to hold a news conference later today, Enmark said. Enmark did not respond
specifically to questions about resident evacuations, other than to say everyone is safe.
Several roads continue to be closed: San Madele Avenue at Brawley Avenue, Corona Avenue
at Brawley, Marty Avenue at San Jose Avenue and Brawley between Shaw and Barstow
Avenues.

10:25 a.m.: Camp America, the recreation vehicle superstore that took over the former
Super Kmart near Brawley Avenue, is closed as police use the parking lot as a command
center. Nearby, on N. Reese, Fresno Unified School District put Lawless Elementary on a
"rainy day" schedule, which means kids aren't allowed outside on playgrounds or fields.

The SWAT team continues to surround the apartment.

8:36 a.m.: Shaw Avenue has been reopened to traffic at Brawley Avenue, but a SWAT team
is still surrounding a northwest Fresno apartment complex this morning, looking for a
man suspected of shooting two Fresno police officers.

64
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e



Brawley is still blocked off north of Shaw, as is Marty Avenue, and San Jose Avenue is
blocked, as well.

The unidentified officers were taken to University Medical Center and were listed in stable
condition with non-life-threatening wounds.

Shirl Catrina, assistant manager of the San Jose Villa apartment complex, told reporters
that she was awakened by the sound of at least four gunshots at about 3:30 a.m.

She said officers have evacuated the complex's 48 townhouse units and were concentrating
on a unit just a few doors away from her apartment. 

7:06 a.m.: A small army of law enforcement officers, including a Fresno police SWAT team,
had a northwest apartment complex surrounded this morning, looking for a man suspect-
ed of shooting two Fresno police officers.

The officers, whose names were not made public, were taken to a local hospital where they
were being treated for what were described as not life-threatening injuries.

The shooting was reported shortly after 3:30 a.m. at an apartment complex just north of
Shaw and Brawley Avenues.

Police said the officers were responding to a "call for service" when they were met with
gunfire when they arrived. The officers retreated to safety on their own after they were
shot.

According to media reports, the shooting happened at the San Jose Villa apartments,
which is located near San Jose and Brawley Avenues.

Police said the shooter is believed to be confined in an undisclosed location and that a
SWAT team was making preparations to try to take him into custody.

Shaw, east and west of Brawley, has been closed to traffic, as well as Brawley, north and
south of Shaw.

Check FresnoBee.com for updates throughout the day and read The Fresno Bee tomorrow for further

details.

Headlines sell the story: Many newspapers are publishing news without the ben-
efit of a copy desk and headline writer these days, either for speed or because it’s
too early for those folks to start their shifts. Stories still need headlines, though,
so reporters are writing them, sometimes for the first time in their career. Addi-
tionally, blog posts need good headlines and news bloggers are rarely staffers
with headline-writing experience.

So what makes a good headline for the Web? 
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“Good headlines not only ought to tell the
news, but also ought to make the reader
want to read the story,” said Rick Arthur, a
copy editor at The News Tribune in Tacoma,
Wash., and a newspaper consultant. “Good
headlines should entice the reader to want
to know more. Indeed, if the story matter is
appropriate, a good headline should make
the reader laugh, make him cry, make him
angry — in short, it should engage him
emotionally, one way or another.”

Arthur has helped newsrooms from MSNBC
to major metro newspapers improve their
headline writing. Here are a few more of
Rick’s tips: 

• Make the reader want to know more.
• Use conversational language.
• Take risks.

John Wesley, who writes a blog called “Pick
the Brain,” discovered the power of head-
line writing in early 2007. On a Friday in
January, he wrote a post titled “The Two
Types of Cognition” that attracted a grand
total of 100 visitors in the next two days. 

He then rewrote it: “Learn to Understand
Your Own Intelligence.” Five days later, the
article had attracted 4,930 unique views.
“Not bad for a site that normally averages
a couple hundred visitors a day,” Wesley
wrote. 

It’s a good example of how a headline that was essentially a label or description
did little to entice readership. But a rewritten headline that engaged the reader
and made him or her want to know more really drove readers to the article.

Contextual hyperlinking: The best online narratives allow readers to “branch off”
and click through to other, more detailed supporting content depending upon a
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Here are some examples from The
News Tribune that helped these
stories make the top 10 list for
most-read stories in a month:

Police files: Car chase, jets,
theft, 9-year-old
Story about a 9-year-old who stole
a car and snuck on a plane from
Seattle to San Antonio.

‘Hokey Pokey’ or hanky panky? 
Story about school cracking down
on dirty dancing.

Homeowner gets Punk’d 
Story about an ad on craigslist
that invited people to take any-
thing they wanted from an unsus-
pecting victim’s house.

Steaks on a plane
New airline security rules banning
the carrying of cold packs on air-
planes make it harder for food
sellers catering to tourists.

For more examples, tips 
and resources, visit 
http://www.copydesk.org/.



reader’s level of interest. Almost all journalism refers to other sources, but online
a writer often has the ability to link readers directly to those supporting sources.
Note the URLs of those sources when you report and work them into your piece
with contextual hyperlinks. 

This is especially helpful when your earlier stories provide background and 
context. Don’t regurgitate — just link to your past work.

Don’t forget art, context, interactivity, multimedia: In the rush to be timely,
it’s easy to forget other story elements that will help the reader. 

• Is a photo assignment needed? 
• How about a locator map? 
• Are there past stories to link to? 
• What about audio and/or video? 
• A message board? 
• A live discussion? 
• A narrated photo gallery? 
• An interactive primer? 

Assignment:
Since reporting for the Web may be new to you, it might be difficult just to
get started. Try this:

1. Write a Web story as a pitch to your editor. Include all the pertinent
information you have and “sell it” as much as you can. If you are waiting
for more information and know when it’s coming, say so. It’s OK to tell
readers that you don’t know everything you want to know right now but
will be updating the story as soon as you do. In fact, it’s encouraged.

Also make sure to check what other news outlets are doing. So if a radio 
station is reporting that the kids in the bus were not wearing seat belts, 
you can write it that way. Just make sure to keep checking sources and if
that information proves wrong, you have to say later that earlier reports
proved to be false.
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2. Use a “charticle:” Some stories are difficult to write quickly with catchy
transitions and fully developed tones. Try listing out the basic facts (who,
what, where, when) and then forming a charticle with those categories.
Also known as alternative story forms, lead-ins like “what happened?” 
and “what’s next?” quickly tell readers what they want to know.

3. Use taglines: Telling readers that your breaking story is not the defini-
tive work on the subject is important. If a more complete story will
appear online or in print (or broadcast) later, say that. It seems like a
promotional device, but it’s really more an issue of thoroughness. If
you’re still working the story and developing something more complete,
readers deserve to know it.

4. Browse these newspaper Web sites for examples:

Minneapolis Star-Tribune: Startribune.com
The Charlotte Observer: Charlotte.com
San Francisco Chronicle: SFGate.com
The Kansas City Star: Kansascity.com
The Honolulu Advertiser: Honoluluadvertiser.com
Milwaukee Journal Sentinel: JSOnline.com

1 Jonathan Dube, "Writing News Online," Poynter Online, July 14, 2003. Jonathan Dube is the publisher
of CyberJournalist.net as well as the editorial director at CBC.ca and a columnist for Poynter Online.
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Chapter 7:

Digital Audio and
Podcasting

Eventually you will be asked to capture audio to go with your story (if you

haven’t been already). Learn the basics of gathering natural sound, recording an

interview and editing the clip (with free software) in this chapter.

Introduction
A challenge for many reporters is to capture in words a story’s particular sights
and sounds. Photographs usually solve the visual end of this equation. Now, with
the advent of cheap digital audio recorders, reporters can bring readers even clos-
er to the story by enhancing their reporting with audio clips.

The basics: Audio formats
It’s helpful to have an understanding of digital file formats as you get started. If
you download or listen to audio on a Web site, then it is probably in a com-
pressed format so that it downloads faster. You’re probably familiar with some of
the formats, like MP3 and Windows Media. It’s not necessary for you to know the
technical differences between them, just know what you’re dealing with. Here’s a
glance at the most prevalent formats of digital audio.

Compressed (on Web sites)
• MP3 (most universal)
• WMA (Windows Media)
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• Real (Real Audio)
• MPEG-4 (QuickTime)
• MPEG-4 AAC (iTunes)

Uncompressed (not found on Web sites)
• WAV (pronounced “wave”)
• AIFF (Apple’s standard format)

Your goal should be to provide audio clips in MP3 format for your readers. Why?
Because virtually any computer can play an MP3. Programs like iTunes, Windows
Media Player or Real Player can play them, too, but they can’t play the other pro-
prietary formats. For example, you can’t play a Windows Media file in iTunes or a
Real Media file in Windows Media Player, but you can play an MP3 on any of them.

Identifying opportunities
If you are a reporter, interviewing people is what you do. Sure, you can transcribe
the best quotes for print but does that really provide a thorough and complete
report? Did one of your sources elaborate on an important topic, which you then
paraphrased to avoid a long quote? Did someone say something with emotion or
feeling or uniqueness that doesn’t transfer to text?

Most news articles can be improved with the addition of audio clips. A newspaper
reporter can easily produce audio clips on more than half of the stories he or she
turns in, based on the subject matter alone. That may sound too ambitious if you
haven’t edited and published audio for the Web before. But once you do it a cou-
ple of times, it will become second nature. 

The first step is to toss that microcassette machine from the 1990s and get your-
self a digital recorder.

Buying a recorder
Like most digital tools, there are plenty of options on the market today and
deciding which one is right for you starts with a basic question: How much can
you afford to spend? You can buy a new digital recorder for as little as $50, but if
you spend even a little bit more you can dramatically improve your capacity to
participate in this game. And, of course, if you spend even more you will go from
“entry level” to “professional” in no time. 
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The key points to consider include recording time, digital file format and compati-
bility with your computer, ease of use and transferring files, and quality of record-
ing. Let’s look at a few options in different price levels and evaluate them on
these aspects. 

Important note: You might be tempted to buy a $50 version because, hey, it says
it’s a digital recorder. But unless you can transfer the files from the recorder to
your computer, you will be unable to get the files onto a Web site where readers
can listen to them. So it would be like writing a story on a computer and not
being able to send it to your editor.

$100 
Olympus WS-100
http://www.olympusamerica.com/cpg_section/
product.asp?product=1170
Recording time: Up to 27 hours. Unit is also a USB 

mass storage device with 64MB of capacity. 
Digital file format: Windows Media, which isn’t perfect

(especially if you’re a Mac user) but does work. 
Compatibility: Files can be quickly downloaded onto a 

Windows or Mac computer through a USB 2.0 port. 
If you have a PC you won't need any additional software. If you're using a
Mac, you will need a file converter to change the WMA files to MP3 or some
other format readable on Mac software such as iTunes. EasyWMA is only $10
and works well (www.easywma.com).

Ease of use: Recording is one-touch and easy. It’s tiny — about the size of an 
iPod Nano — so very portable. Has mike and headphone inputs, which are 
required. It’s clunky to review recordings with fast forward or rewind. This 
can be done more easily on your computer.

Battery: One AAA battery.
Transferring files: The best feature on this recorder is the built-in USB port. Just

pull apart the device and directly insert the recorder into your USB port. No 
extra wires to pack along. 

Quality of recording: As good as it gets for $100.
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$200 
Diasonic DR-51128
http://www.justrecorders.com/dr51128.htm
Recording time: 35 hours. Unit is also a USB 

mass storage device with 128MB of capacity.
Digital file format: MP3 or Windows Media.
Compatibility: Windows or Mac.
Battery: Two AAA batteries.
Transferring files: USB connection allows for easy 

drag and drop of files.
Quality of recording: Good.

$400
Edirol R-1
http://www.rolandus.com/products/product

details.aspx?ObjectId=744
Recording time: 137 minutes when using the 

included 64MB memory card.
Digital file format: WAV.
Compatibility: Mac or Windows.
Transferring files: USB 2.0 or memory card.
Quality of recording: Excellent.

$350-500
M-Audio MicroTrack 24/96
http://www.m-audio.com/products/en_us/MikeroTrack2496-main.html
Recording time: Ample, depends on size of memory card.
Digital file format: WAV or MP3.
Compatibility: Mac or Windows.
Ease of use: Simple yet powerful.
Transferring files: Compact Flash (CF) cards 

make it simple.
Quality of recording: Excellent.
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Using a microphone
While using an external mike can be an extra nuisance during an interview, the
added sound quality is well worth the effort. 

There are basically two types of external microphones: A standard mike with a
cord, and a wireless or lavalier mike. Let’s take a look at the advantage both have
to offer and also explore the best way to record telephone calls digitally.

A standard mike with a cord is helpful if you are interviewing more than one per-
son at a time or you want to include your voice on the audio clip so listeners can
hear the full interview instead of just selected quotes. It is also the best way to
gather natural, or environmental, sound, which can be spliced into the audio seg-
ment to enhance the listening experience.

Gathering natural sound is not the same as background noise. Interviews should
be done in a setting that allows the voices to be recorded without interruption.
Separate from the interview session, however, it’s always a good idea to search for
those sounds that will help describe the setting. Are there power tools being
used? Is it a noisy office with lots of chatter and phones ringing? Is it an outside
setting where you can hear the bugs and the birds? 

If there is natural sound to be had, take just a few minutes and record it — with-
out anyone talking. “You might feel silly just standing there holding your mike in
the air, but when you get back to edit your stuff, you’ll be glad you have it,” said
Kirsten Kendrick, a reporter and morning host on KPLU radio, an NPR affiliate in
Seattle and Tacoma. 

You should record natural sound in uninterrupted 15-second increments. That way
you’ll avoid the problem of not having enough to use in editing. You can always
make a clip shorter by cutting it but you can’t make it longer, so make sure the
material you’re working from is long enough to cut from.

Assignment: 
Find the NPR station near you or listen online from NPR’s Web site. The 
public radio broadcasters do a masterful job of weaving natural sound into
their reports. And as a listener, you get a better sense of the setting for the
story when you hear what it really sounds like. 
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A wireless or lavalier mike is most helpful when your
goal is to capture the voice and words of one person and
you’re “in the field.” While they might be intimidating at
first, wireless mikes are really very simple. 

There are two halves: A battery pack and miniature mike
on a cord that clips on the person you want to record
(this sends the signal), and a battery pack and cord that
goes into your recording device (this receives the sig-
nal). Here’s how to get started:

1. Clip the mike on the lapel of your subject and give them the battery pack to put
in their pocket. Don’t forget to turn the device on! 

2. Connect the receiver pack to your recording device, turn it on, and put it in
your pocket or purse or handbag. Then operate your recorder as you normally
would: Hit the record button when you’re ready and pause button if there’s a
break in the action. 

Recording with your computer
To record a phone call digitally, you’ll need another piece of equipment: A tele-
phone recording control unit that sells at Radio Shack for $25. Many journalists
already use one of these to record phone calls to their analog microcassette tape
recorder. And those same journalists probably have an unruly jungle of tapes on
their desk or in a drawer that is unlikely to produce the tape from six months ago
that someone might need. (NOTE: In some states it’s illegal to record someone on
the phone without their express permission.)

That’s one reason to go digital — organization. With the Radio Shack device you
can record directly to your computer, which makes it easy to store files in an
organized fashion. And going through the “tape” is easier on a computer since
most playback programs like Windows Media Player have slider bars that allow you
to quickly go from the beginning of a recording to the end. 

Your hardware is ready. Now you need software to manage and edit the sound files
with your computer. There are literally hundreds of options for audio software,
ranging from Adobe Audition (the choice for most radio professionals, $349) to
Audacity and JetAudio, popular free downloads that work great.
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No matter which audio software you use, there are a few basic settings on your
computer to check before starting your first recording:

• File name: You will either need to select File -> New and create a file or
choose where on your system this new file will be created. Either way you
need to think about what to call your file. This is a good time to come up
with a standard file naming convention that will serve you for months and
years to come. Include the date and the name of the person you’ll be talking
to, so an interview on Valentine’s Day with Paris Hilton would be named
“021407hilton.” It’s also helpful to create new folders by year or month for
more organization.

• Format: You should record in WAV format so your files are uncompressed and,
therefore, of the highest quality. You can convert the files to MP3 (Audacity
and JetAudio can both do this) once they’re edited for publishing on the Web.
You only need to worry about this when recording directly into your computer,
not when using a digital recorder. 

• Input/Mike level: Make sure the software is set to capture data via micro-
phone input. Then find the setting that adjusts the microphone level and set
it to about 70 percent of the possible level. 

Assignment: 
Now call a friend and record the call for a trial run. Save the file with your
new naming convention. Play it back to make sure it sounds good. 

Editing your audio 
It’s unlikely you’ll ever publish an entire session online. Just like you don’t pub-
lish entire interviews in text, you need to edit your audio to make sure the best
stuff is not obscured by less compelling, less important or repetitive content.
Editing audio is remarkably similar to editing text, so you shouldn’t be intimidat-
ed when approaching this task.

First, acquire the audio file if it’s still on your recording device. Connect the dig-
ital recorder to your computer through USB and drag the file(s) you need into a
folder or onto the desktop. Important note: Most — but not all — digital
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recorders come with a USB cord that connects to a computer to make this easy
(simply plug the cord into the recorder, then connect it to the computer through
a USB port). The cheapest recorders, however, do not interface with computers,
making them much less useful. 

Launch your audio-editing software. Ideally, the program should be easy to use
and export files in MP3 format. If you use a PC or a Windows machine, Audacity
and JetAudio are excellent free options. Let’s go through the editing process with
Audacity since it appears to be the most prevalent free software in use today.

Editing with Audacity:
1. Use File -> Open and open the audio file

2. Crop out the bad stuff: Think about how users would best appreciate the con-
tent — in one full serving or broken up into smaller bites. Highlight areas that
represent unwanted ums, ahs, mouth noises and lip smacking. Then simply hit
DELETE. Also crop out silence and any small talk at the beginning and end. 

Assignment:
Record your own voice as a test. Count from 1-10 into a microphone and
capture it digitally. Then edit your take. Highlight the section where you
say “3” and select Edit -> Cut. Then move the cursor to after the “6” and
select Edit -> Paste. Repeat a few more times with other numbers. This
will give you a feel for how the sound waves represent words and sounds
and also show you how easy it is to edit audio.

76
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e

A Sound file ready for editing in Audacity.



3. Make it stereo: Some files will be mono,
not stereo, meaning you’ll only hear the
audio in one side of your headphones. You
want to make it stereo so the sound file
will play in both sides of speakers and
headphones, instead of just one. To make
it stereo, click on the Audio Track label
next to an upside down triangle (see
screen shot.) Then select Split Stereo
Track from the drop-down menu. 

Then copy the region that you’ve edited
by highlighting it and using Edit -> Copy. Then click into the lower window
and use Edit -> Paste.

4. Export the file: Convert your audio edit into a compressed, ready-for-online-
publishing MP3. Just go to File and select Export as MP3. Ignore the meta
data interface (Author, Description, etc.) unless you’re doing a podcast.

Using time points for speed
Most newspaper journalists will do what they know first — use the audio to get
quotes so they can write their story before they edit the audio for online publish-
ing. That’s great. But think about the audio editing you will do next as you listen
to the entire take. If you make a note of the time when a good quote plays, you’ll
save loads of time when you go back to edit the take for the good stuff. 

All audio-editing software programs feature convenient time track marks, so if
your interview’s best quote occurred 10 minutes into the interview, you write
“10:00” next to the quote in your notebook. Then go directly to the 10-minute
mark on the track when you’re ready to edit and you’ve saved yourself 9 minutes,
59 seconds.

Ready for podcasting
Podcasting is the distribution of audio files over the Internet using RSS subscrip-
tion. The files can be downloaded to mobile devices such as MP3 players or
played on personal computers. The term podcast, (Playable On Demand + broad-
cast) can mean both the content and the method of delivery. Podcasters' Web
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sites also may offer direct download of their files, but the subscription feed of
automatically delivered new content is what distinguishes a podcast from a simple
download. Usually, the podcast features one type of “show” with new episodes
available either sporadically or at planned intervals such as daily or weekly.

Podcasting with video files is often referred to as vodcasting (video + podcast-
ing). It works the same, but includes video. If you download a vodcast on an MP3
player that doesn’t have a video screen, you will still be able to hear the audio.

In format, podcasts are similar to conventional radio programming with a host or
hosts interviewing a subject, playing music or introducing pre-recorded audio sto-
ries. So it’s no surprise that National Public Radio produces some of the most pop-
ular podcasts online. 

Newspaper podcasts: Dozens of newspapers are podcasting, including The 
New York Times and The Washington Post. 

The Naples Daily News produces daily podcasts and vodcasts complete with hired
voice talent to deliver lead-ins, sponsorship messages, quick weather forecasts,
brief headlines, reporter inter-
views about a big story, sports
headlines, selected letters to
the editor, calendar picks 
and teasers to other items 
on the Web site (http://www.
naplesnews.com/podcasts/).

The San Francisco Chronicle
was producing two dozen pod-
casts as of January 2007 on
topics as diverse as the San
Francisco 49ers football team,
wine and movies. 

Listening to podcasts in
iTunes: If you have iTunes,
finding and listening to podcasts is simple. Just click the Podcasts link in the left
menu, then click Podcasts directory on the bottom of the screen. Search by cate-
gory or most popular. Click Subscribe if you’d like to add a podcast to your col-
lection and it will automatically update any time there is new content.
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The podcasts homepage on the San Francisco
Chronicle’s Web site (http://www.sfgate.com/
cgi-bin/blogs/sfgate/indexn?blogid=5).



Setting up a podcast: If you know you will have regular audio files on a specific
topic to offer to readers, setting up a podcast will make organizing and publishing
the audio convenient for you and your readers. A good example is a sports beat
writer who records interviews with coaches and players and wants to offer them
to readers. Setting up a podcast will allow a reader to subscribe and automatically
receive new files as they become available. 

Creating a podcast that others can subscribe to is easy and free — if you have an
RSS feed set up. (See Chapter 2 for how to set up an RSS feed.) Go to iTunes and
click on the Submit a podcast logo or use another service like Podcast Alley.

If you don’t have an RSS feed set up for your audio files, talk to your Web staff
(if available) or visit http://www.podcast411.com/howto_1.html.
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Chapter 8:

Shooting and Managing
Digital Photos

Everyone can use a better understanding of digital photo basics, both for

shooting mug shots and managing the handout photos that news organizations

will continue to rely on.

Introduction
“Just have them e-mail a photo,” is often heard in newsrooms these days. The
proliferation of digital cameras means that photos are almost always an option. 

To make the most of this digital development and to further your digital literacy,
you should understand how digital photography works. This overview is intended
to assist those who may handle digital photos and need to shoot a basic picture
like a mug shot. 

There is an ocean of information online for those who want to get more serious
about digital photography and photojournalism. Following is a “starter course.”

The basics
Digital camera sales continue to grow each year with millions of units flying off
store shelves. The advantages of a digital camera over a traditional film camera
are many, including:

• You can take as many pictures as you want and see right away if you got the
picture you want.

Chapter  8: Shooting and Managing Digita l  Photos
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• You can upload pictures to your computer and share them with friends and
family anytime via the Web.

• You don’t have to buy film, and you don’t pay to print photos you don’t want,
so you save money.

Many fields use digital photography every day, including police officers, fire 
fighters, real estate and insurance agents, scientists, doctors and dentists.

The key to understanding how to work with digital photographs is all in the pixels.
Pixel is a mashed-up word meaning PICTure ELement and is usually imagined as a
tiny square on a matrix overlay on a computer image. A pixel is the visual repre-
sentation of data in a digital image or graphic. To picture this in your mind, think
of a mosaic where a photograph is composed of hundreds or thousands of tiny
squares.

If you are shopping for a digital camera, the first measurement you’ll use to 
narrow your choices is the megapixel. A megapixel represents one million pixels.
It is used to measure the power of digital cameras with some simple math. For
example, a standard digital camera is rated at 3.2 megapixels because the largest
photographs it can capture are 2,048 pixels wide and 1,536 pixels tall and 2,048
x 1,536 = 3,145,728 (and the manufacturers round the number up for marketing
purposes). If you used all the information in a 3.2 megapixel image, you could
print a high-quality photograph that is roughly 5 x 7 inches.

Cameras store photographs as digital files on a memory card (see box for more 
information). The more pixels in a photograph, the more bytes needed to store the
picture. Cameras can be adjusted to lower
the number of pixels captured to save
space on the memory card, but now that
large memory cards of 512MB or even 1GB
are so cheap, it’s rarely necessary.

Now that you understand pixels you 
can begin to get your head around 
resolution. When it pertains to the dis-
play of electronic data, resolution is a
measurement of pixels that are available
to the human eye. Computers have dis-
plays that can be adjusted to show more
or less information on the screen. (A
common display setting is 1024 x 768.) 
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About Compact Flash and Secure
Digital memory cards:
A memory card is a critical compo-
nent to digital photography: It's
the thing that holds the pictures.
Essentially it’s like a reusable disk
for storage. The most popular
types of flash memory cards for
use in digital cameras are: Secure
Digital (SD), Compact Flash (CF),
Memory Stick (MS), MultiMedia-
Card (MMC), xD-Picture Card (xD)
and SmartMedia (SM).
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When it comes to photographs, resolution refers to the number of pixels in an
image. Since most computer monitors display 72 pixels per inch (ppi), photo-
graphs on Web sites only need a resolution of 72 ppi. Photographs in a printed
newspaper are usually 200 ppi and a glossy magazine uses images at 300 ppi. 

A photograph will be much larger in bytes at 200 or 300 ppi, and therefore will
eat up more computer processing time to upload or download and will not display
any sharper on a 72 ppi screen. So there’s no reason to make users wait for the
longer download for the higher resolution image. This is the problem when a
reporter finds a photograph on a Web site and would like to include it in print.
The low-resolution image doesn’t scale to 200 ppi and will look blurry, especially
if it is enlarged.

Conversely, if you have a high-resolution image for publication on a Web site, it
should be compressed. Compressing an image means using software to squeeze
the image, omitting the pixels that aren’t necessary and making the file smaller
(in bytes) without sacrificing the overall quality. 

Shooting basic photos with a digital camera
The great advantage of a digital camera is the ability to review the photo on the
camera’s screen. Use this feature! If the photo is bad, shoot more. The more you
shoot and the more adjustments you make based on what you see on the camera,
the more you’ll improve the chances that you’ll get the photo you want. 

Lighting is critical to photogra-
phy, and there are essentially
three ways to shoot a photo:

1. With natural (or ambient) 
light only.

2. With a flash as the primary 
light source (in a low-light 
situation).

3. With a mixture of flash and
ambient light. 

The best photographs are shot when nature provides the right light. But be careful
not to shoot in harsh, bright sunlight, especially if you’re shooting people. If the
sun is in front of the subjects, it will create face shadows and make the people
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Cloudy and partly
sunny days actually

provide the best light
for photography.



squint. If the sun is behind the subjects, their faces will be dark. You can com-
pensate by “forcing the flash” in this situation, meaning you can use the flash
setting on the camera to override the automatic function and make the camera
use the flash.

Cloudy and partly sunny days actually provide the best light for photography.

Here are some additional tips to help your shooting, courtesy of Craig Sailor, for-
mer photo editor at The Olympian and The News Tribune newspapers in
Washington state: 

• Hold the camera steady: Dig your elbows into your body or place them on
something. Use two hands. Lean against a wall. Do anything you can to be
still when shooting.

• Use the automatic settings: Today’s digital cameras are built with advanced
automated settings. Try these first and see if they work. If not, make adjust-
ments. Force the flash or turn it off. Adjust the shutter speed setting.

• Fill the frame: When shoot-
ing people, don’t leave too
much “head room” or space
above their heads. The sub-
ject’s face should be near
the top of the picture, not
in the middle.

• Focus on one thing: When
shooting a person or group
of people against a busy,
complex background, focus
on the person’s eyes. The automatic focus function can only focus on one
thing in the image and a person’s eyes will make the photo look the sharpest.

• Get closer: Most amateur photographers fail first by not changing their posi-
tion. They see something they want to capture on photo and take out their
camera and shoot the photo without moving around. A professional photojour-
nalist, on the other hand, will move all over the place to get the right angle.

• Go vertical: If the subject is vertical turn the camera into a vertical position
to shoot it.

• Shoot action: Capture moments whenever possible and avoid posing people.
Find the setting on your camera that snaps the shutter at 1/500th of a second
or faster to shoot anything really fast such as sports.
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Most amateur 
photographers fail
first by not changing
their position.
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Shooting mug shots: The mug shot is the most common assignment for journal-
ists who are not photographers. While it seems like this would be a no-brainer
assignment, there are several things to consider when framing a head shot.

• Use the right lighting. Try to avoid using a flash if possible to prevent shiny
spots on the person’s face. Move the person outside or near large windows to
take advantage of natural light and then make sure there are no weird shadows
on the person’s face.

• Avoid high noon sunlight and strong backlight.
• Take advantage of overcast skies; they work well.
• Use a flash as a last resort.

• Pick the right background. Make sure it’s as neutral as possible and simple,
not busy; and darker is usually better than lighter. 

• Don’t back the person up against a wall or you’ll end up with flash 
shadows behind the subject. 

• Make sure there isn’t anything like a lamp or pole “growing” out of the
person’s head.

Editing photographs digitally 
There are many software programs that will make editing digital photographs easy.
No matter which program you use, it’s a good idea to follow a few simple steps: 

• Only edit a copy of the photo — not the original. When you open a photo
in an editing program, do a “Save As” and change the file name by at least
one character. This will give you an exact copy of the original just in case your
editing goes awry.

• Crop the photo. Few, if any, photos are perfectly composed when the image is
made by the camera. Use the program’s cropping tool to omit unnecessary
information in the photograph. Cropping a photo should answer the question:
What’s the most important information of the photo? 
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If you right-click or con-
trol-click on any Web
site image, you will see
this drop-down menu,
allowing you to save the
image to your computer
or view the properties to
see how large it is in
pixels.

• Resize the picture. If you are posting a picture to a blog, for example, all 
you need is a small, low-resolution image. Not sure how big? To find out how
many pixels wide to make your photo, find a photo that is about the target
size somewhere on the Web. Right-click (or control-click if you use a Mac) and
select Properties. A pop-up box will display the measurements of the image in
pixels.

Software programs: Whether you work on a Windows computer or a Mac, you
should have a basic photo editing program installed already. You can learn how to
use those programs to perform the most basic operations with the following tips.

If you want to get more serious about photo editing, check out:
• Photoshop: The professional industry standard ($649). 
• Photoshop Elements: A stripped-down version for non-professionals ($89).
• GIMP: A free, open-source program designed to operate like Photoshop.

As simple as it gets: If all you need
is to crop or resize a photo, try the
online service at snipshot.com. It
only takes a few moments to upload
a photo and crop it down to the part
you really need. 
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Microsoft Photo Editor:

• Open a photo. 
• To crop, use the select tool (the

dotted line rectangle). Drag on the
image until you have omitted the
areas that aren’t necessary. Select
Crop under the Image menu at the
top. When presented with a com-
plex box with lots of measure-
ments, ignore it and click OK.

• To resize, select Resize under the
Image menu. In the pop-up box,
change the unit of measurement
to pixels and enter the desired
width. Click OK.

To compress the image for display
on a Web site or blog:
• Choose Save As… under the File

menu at the top. 
• Select More>> in the lower left of

the pop-up box. 
• Slide the arrow on the “JPEG

quality factor” toward Smaller
file/lower quality. Depending on
the resolution in the image, you
may be able to go all the way
down to 10 on the 1-100 scale.
(You’ll need to experiment with
this setting.) Basically, what
you’re trying to do is squeeze the
image as much as possible with-
out affecting the quality. So as
long as you don’t see a noticeable
change in the picture (blurriness,
pixelation, jagged lines), keep
dialing down on the quality. 

86
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e



Microsoft Office Picture Manager:

Microsoft Photo Editor has recently been discontinued
as a component of Microsoft Office, although many
newsrooms still have Photo Editor software available.
Replacing it is Microsoft Office Picture Manager.

The Web photo editing functions for both
programs remain similar, though the Photo
Editor menu items — Crop, Resize, Save
As — are now found in a new place.

In Picture Manager the editing tools —
now called  Crop, Resize, Compress, and
Export — are found in a separate drop-
down menu accessed from a special menu
tab labeled Edit Picture. The Compress
menu is a shortcut to reduce image resolution to
72 pixels per inch and scale the image size to fit
in a 448 pixel x 336 pixel window.

iPhoto for the Mac: 

• Select a photo by double clicking on it. 
• If you don’t see a group of tools on the bot-

tom of the screen (like “Rotate,” “Crop,” “Enhance”) click Edit on the bottom
panel and a new group of tools will appear. 

• To crop, select the crop button and a border will appear on the photo. Drag
the sides, top and bottom in toward the center of the image until you have
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omitted the areas that aren’t necessary. Hit enter or return.
• The Red-Eye function works easily; select the tool, and then click each red 

eye with the wand. 
• Click Done.

To resize and compress the image for display on a Web site or blog, choose
Export under the File menu at the top. Select “scale images no larger than” and
enter the desired width in pixels. Click export and save the compressed image to
your desktop (or other desired location). 

Summary
Since journalism is about providing readers and viewers with information, the
addition of photographs is fundamentally just good journalism. Pictures are infor-
mation, so if you’re a reporter, you will become a better one if you learn to take

photos on assignments. This won’t
replace the assignments when you need
a professional but will supplement them
by adding mug shots and other basic
photos to all the stories that currently
don’t have accompanying art. 

And if you have a blog, it’s even more important. Blogs without art are lame. 

Assignment:
1. Practice shooting like a pro: Take a digital camera (borrow one if you

must) and try to shoot the best pictures possible of someone you know.
Shoot mug shots, portraits and documentary shots that capture them
doing what they do.

2. Use picture editing software to crop and resize the photos.

3. Upload the best of these photos to a Web site like Flickr. The mechanics
of getting a photo from A to B will be helpful.
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Blogs without art 
are lame.
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Chapter 9:

Shooting Video for News
and Feature Stories

Quickly learn how to shoot video for a story in a way that looks professional

and doesn’t require hours of editing to produce a clip.

Introduction
The quality of video journalism by newspapers has dramatically improved in the
past few years. Yes, you read that right. Newspapers are producing some of the
best video journalism in the U.S. and around the world. Instead of being broad-
cast on television, however, most of these video stories are published on the Web.

The advent of (relatively) cheap digital video cameras and free video-editing soft-
ware has leveled the playing field just as the Internet did with text publishing.
Instead of a $35,000 camera, an expensive editing station, a two-person crew and
years of training, one person can produce high-quality Web video with a $500
camera and a laptop or desktop computer. 

As a result, some TV news companies are breaking up traditional news teams and
creating VJs — video journalists. Also known as “backpack journalists,” they work
solo and serve as both reporter and videographer on assignment.

The lower entry barriers also have influenced secondary education. Around the
U.S., thousands of high school and junior high students are receiving formal 
training in shooting and editing video at school. Those that go on to journalism
school will graduate with a broader array of skills than most of the journalists
working today.
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David Leeson, a Dallas Morning News photographer who shared a 2004 Pulitzer
Prize, wrote a passionate plea for diversification of skills on the SportsShooter
Web site in November 2006. In it, he compared the newspaper industry to a 
distant aunt visiting a reunion for the first time in 25 years. 

“Last time you saw her you were sitting in a booster seat. Today she
appears a tad smaller than before and marvels at how big you've become.
Video was a child when most of us first picked up a 35mm. Now, video is
all grown up and on its way to becoming a powerful storytelling tool.”

“If you had the skills in video today — there would be a very long list of
opportunities before you,” Leeson wrote. “To move forward in life requires
a measure of risk. There is no greatness outside of risk. The future of the
traditional newspaper is looking pretty risky these days but the health of
solid visual reporting is getting stronger every day by those of us who
value visual journalism and ethical storytelling above and beyond a
35mm.”1

These next chapters will help you understand the basic concepts of shooting and
editing digital video with enough step-by-step instruction that you will be able to
pick up a camera and shoot footage then edit it and publish it online. It’s that easy.

Digital video cameras
Those grainy home videos you watched as a child are long gone. Digital cameras
have done to video what CDs did to old record albums. By storing video as digital
bits on a mini-DV tape, compact and portable
cameras are able to collect and store much more
data than analog tape, greatly improving the
quality and making editing a breeze.

Digital cameras can be separated into two types:
1 CCD and 3 CCD (CCD = charge coupled device).
These measures tell you whether the camera has
one computer chip or three computer chips.
Cameras use these chips to process color and, as
you might suspect, having three is better than
one. As a result, 3 CCD cameras produce much higher quality video but are also
more expensive. A 3 CCD camera costs $1,500-$5,000 while a 1 CCD camera can 
be had for less than $1,000.

An example of a 3CCD camera,
the Canon GL-2.
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The additional quality of a 3 CCD camera is not really necessary for basic Web
video (since the files are compressed to speed up the download time) but that
quality is required for TV. If you ever want to make a DVD and watch it on a flat-
screen plasma TV, a 3 CCD camera will make all the difference.   

Tapes, batteries and other accessories
Several hours before you need to use the camera, check to make sure the battery
and back-up battery (if there is one) are completely charged. Most cameras come
with a standard battery that won’t cut it for many professional uses because it
lasts less than an hour. If possible, purchase the largest capacity battery available
for your camera and then use for back-up the one that came with the camera. A
three-hour battery is available for most cameras.   

Also, check to make sure you have enough mini-DV tape for the assignment plus a
back-up tape in case you need more than you originally anticipated. Tapes can be
re-used, which is nice since they’re not cheap (about $7 for a 60-minute tape). 

While a charged battery and ample tape are the most important accessories you’ll
need for your shoot, there are many others to consider, including external micro-
phones (see Chapter 7: Digital Audio), external lighting devices, a tripod and
headphones.

Tripod: The easiest way to make your videography look professional is to always 
use a tripod. A steady shot is essential for quality video and, even though many
cameras have fancy “image stabilization” features built in these days, nothing will
provide a rock solid shot like a tripod. That said, developing a steady hand is neces-
sary if you’re going to start branching out and doing different types of shooting.

All cameras have a round (usually silver) hole on the bottom with circular threads.
All tripods have a round (usually silver) bolt-like stem on the top. All you have to
do is place the camera on top of the tripod so the stem matches up to the hole
and then turn the dial below the stem until the camera is tightly affixed to the
tripod.

Headphones: As we will discuss later, audio is essential to video. And the only
way to be sure you are recording good audio with your video is to plug in a pair
of headphones and listen while you shoot. All cameras have a headphone jack;
simply plug in the headphone cord.

If it’s not practical to use headphones during the shoot, use a co-worker or the



subject to test the audio while setting up the camera to check the audio level.
Simply talk to them while wearing the headphones to make sure the mike and
sound are working correctly. 

Lighting: If you have ever “shared” an interview with a cameraman from the local
TV station, you probably thought, “Why do they have to use that spotlight? It’s
blinding the person talking.” 

There’s a good reason. Just as still photographers need a flash in almost all
indoor settings, powerful lighting is essential to shooting video. 

There are several options for lighting, spanning various price ranges. Most clip
into a “shoe” on the top of the camera. As with most photography equipment, the
better products are more expensive. In this case, more powerful lights are brighter
and give off more even light. So if you don’t have access to the big, bright lights
that TV people use, look for a more “entry-level” version for around $100.

Or do as I did covering the Super Bowl in 2006: Stand next to a TV cameraman
and mooch off his light.

NOTE: Running a light — especially a powerful one — will increase the drain on
your battery, so having a back-up battery is even more important. 

Zooming, focusing and exposure
Digital video cameras all come with convenient automatic features as the default
settings. Unless you’re a “camera person,” you probably won’t ever switch to 
manual settings. And that’s fine; let the camera do the heavy lifting for you. 

Focus: The automatic focus feature means that when you turn the camera on, it
will automatically focus on whatever you’re pointing the camera at. This will 
suffice for most of your shots. The only time it might not be good enough is
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The “shoe” is where you connect an external
device such as a light or shotgun microphone.
The “zoom” rocker bar lets you zoom in on, or
away from, your subject. 
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when you are shooting something complicated where there are multiple subjects
moving within the frame. Still, the automatic setting will probably produce a 
better picture than you could using the manual focus dial unless you already have
photography skills.

Zoom: Most new cameras have a powerful zoom that is easily manipulated with a
rocker button on the top of the camera. Set the zoom before beginning to record
and then only zoom when absolutely necessary — and as slow as possible. If you
are shooting someone talking, don’t zoom at all. Ever. If you want to have dif-
ferent angles and compositions, do separate shots.

Exposure: Most cameras also come with automatic exposure, which will give you
the appropriate lighting in most circumstances. If you are shooting in especially
low light, try switching to manual exposure and allowing more light (this will
open up the iris). Check the operating manual for information specific to your
camera.

Get good audio
One part of the equation that is easy to overlook when shooting video has 
nothing to do with the picture. The quality of the audio is critical to producing
good video, even more so for online video since the size of the video picture will
be relatively small. 

Natural sound and environmental pictures are also important. Remember to record
“blank” shots of a story’s location or setting. Think of the standard “60 Minutes”
piece: It shows the outside of a building where the subject works, then cuts to a
shot of the subject walking up the street or answering phone calls in the office.

The best way to ensure the quality of the audio will enhance, not sabotage, your
video project is to choose the best microphone for the assignment. Here are the
options:

Built-in mike: All digital cameras have built-in microphones that will capture the
audio sufficiently if you are shooting video and want “natural” or “environmental”
sound. Think sporting events, fairs and festivals, and the like. 

Wireless mike: A lavalier, or wireless, microphone is an additional accessory that
is essential to purchase if you want to capture interviews on video. Here’s how to
use one:



1. A tiny mike on a clip is clipped onto the
lapel of the subject. This mike is wired to a
transmitter that can be clipped on the sub-
ject’s belt or placed in a pocket. 

2. The receiver is then connected to the camera
by plugging the cord into the jack marked
“mike” (or it might have a small icon that
looks like a microphone).

3. Turn both units on — the transmitter and the receiver — and test the 
signal strength by using headphones and asking the subject a couple of
“small talk” questions. If the signal isn’t strong, turn up the levels on both
devices. If that doesn’t work, look for a better place to put the mike, one
that’s closer to the subject’s mouth. 

Note: Remind the subject that the mike is sensitive and to avoid adjusting 
clothing during the interview or there will be loud scratches. 

Shotgun mike: Another accessory, a shotgun mike, is the best choice when you
are hoping to capture a conversation among several people. To place wireless
mikes on more than one or two people will make the sound unrealistic and too
“out front.” (Plus, you may not have access to a half dozen wireless mikes.) 

There are two types of shotgun mikes: Smaller
ones that attach directly to the camera and
larger ones that attach to a boom. If you have
the on-camera version, slide the mike into the
“shoe” on the top of the camera. The camera
will recognize the accessory and automatically
switch from its built-in mike to the shotgun
mike. 

A larger shotgun mike will probably be wireless
and have a transmitter and receiver. You will
need a boom — an extendable pole with a
microphone clip to hold the mike — and
someone to hold it near the subjects (you
have a sound crew, right?). But not too
close, or you’ll end up with a video that has
shots of the mike poking in from the edges.
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A shotgun mike on a boom.
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A shotgun mike on a camera.



95
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e

Shooting still images
Most new digital video cameras have the abili-
ty to take still photographs, too. This will
come in handy for shooting a “screenshot” or a
mug that can be used in print to tease to the
online video package or on the Web site as a
promotional icon. 

Switch the camera mode to Card mode instead
of Tape mode (if your camera has this option).
This will change the recording source from the
DV tape to the portable storage card that your
camera uses, such as a Secure Digital (SD) or
Compact Flash (CF) card. 

To capture a photo, use the button marked
“PHOTO” instead of using the red (or other)
button that is used to begin a recording. You
can (and should) use the regular zoom. 

Shooting the video
When you’re starting out, there are essentially
two types of video assignments: A documentary-
style video story and a breaking news/high-
lights/news clip style. Either form requires you
to approach it with more than an attitude that
you’re “just getting some video.” With a little
more effort and planning, you can capture and
produce great video, no matter the form. 

Documentary-style video story

The best way to make a solid video story is to
think about it the same way you think about
writing a story. Indeed, it’s critical to think
about how the video will “tell the story.” Once
you envision what the story should “say,” it’s 
simply a matter of filling in the spots with the

Armed only with a cell phone?

So-called “citizen journalists” are
increasingly using their mobile
phones to capture video if they
witness a news event. They may
upload these videos to hyperlocal
sites or they may send one to a
news organization that welcomes
on-the-scene reports.

To capture mobile video you
need, of course, a mobile device
that can shoot video. Many cell
phones are now equipped with
USB ports that allow you to con-
nect your phone directly to your
computer so you can transfer
your video and edit it. If that’s
not an option, you can also 
e-mail the video to yourself and
then edit it.

To e-mail video, your cell phone
must be able to send MMS
(Multimedia Message Service)
messages and have an Internet
access or data plan from your
mobile service provider. 

Increasingly, news sites are 
inviting people to send them raw
video footage, especially of
breaking news. CNN.com’s I-Reports
and the video-hosting site
YouTube invite mobile videogra-
phers to upload their videos
directly from their cell phones 
or PDAs.

You must create an account. This
will give you an e-mail address
where you can send your videos.
Then you can e-mail your video
as an attachment.



most appropriate footage. Here’s how.

Plan the shoot before you go out: Just like the elements of a good news story
that are second nature to you (background, quotes from more than one source,
documentation), there are basic elements of a shoot you will need to construct 
an interesting video story. You need a mix of shots:  

• Wide-angle — These shots,
also known as “establishing”
shots, give viewers a sense of
the environment, so shoot the
outside of the building or back
up and shoot the entire room.

• Medium — Somewhere in
between wide and close-up,
these shots are the ones you
are probably most comfortable
shooting.

• Close-ups — These shots 
zoom in on who’s talking or
what they are talking about.
Remember: Always zoom first,
then record, instead of recording
and zooming at the same 
time.

A good mix would be 25 per-
cent wide-angle, 25 percent
close-ups and 50 percent 
medium or mid-range shots.

Chapter  9: Shooting Video for  News and Feature Stories

96
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e



97
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e

Breaking news/highlights/clips style video

For these types of video, you rarely know what the “story” will be in advance. You
simply know that news is happening or has happened and you want to capture
some essence of it on video. 

For a breaking news event like a highway crash or a school shooting, you probably
won’t get to the scene in time to capture the actual action. However, the reaction
from witnesses and investigators as well as footage of the scene are well worth
capturing.

Press conferences (if they are tied to compelling news events or delivered by news
figures) can make good video and are about the easiest to shoot. You have a fixed
subject and the lighting will be good (especially if there are TV cameras around).

Highlights clips, especially in sports, can be among the most popular content on
any news site. Shooting sports video can be challenging, however. The constant
movement of the subjects requires large capacity in the digital video file and can
be hard to follow once the video is downsized and compressed for Web display. As
a result, short clips of the best action is the way to go, either edited together
with voice-over descriptions or linked to a news story as raw clips with caption
information next to the link. 

Other important tips to remember:

Be selective in shooting. There are two good reasons for this: You don’t want to
waste tape and you don’t want to waste time editing. 

Avoid panning, zooming. Stop recording when switching between wide, medium
and close shots. Avoid zooming and panning if possible. Simply shoot a shot, stop
recording, then adjust for the next shot and hit record again. 

Hold your shots. Since you can make a shot shorter in the editing process — but
not longer — make sure to hold each of your shots for at least 15 seconds. Even
if it’s a wide environment shot that you’ll likely use for 5 seconds, shoot the full
15 seconds. You’ll be glad you did.

Be silent when you shoot. The camera will pick up every sound you make — 
a sigh, a cough, a chuckle or anything you say. So keep your lips zipped when
recording because you won’t be able to edit out the unwanted audio later. 



Frame your subject carefully.
When framing your shot, it is best
to avoid a static composition by
keeping the main subject slightly
off center. To do this consistently,
follow the “rule of thirds,” which
recommends dividing the frame,
using imaginary lines, into thirds
both horizontally and vertically. 
If you position your main subject
(usually a face) near one of the
intersections of these lines, you
will achieve a pleasant, active
composition.

Seek the best short clips. Understand that the best video stories are comprised
of many short clips edited together, and your job is to get the best short clips.
The best way to fully comprehend the array of clips you need to capture is to
actually perform the editing — or at a minimum sit with the person who edits
the video. It’s the only way to see what types of clips you shot work best and
what types of clips you missed. 

If you shoot video footage and hand it off to a Web producer or multimedia editor
to await the final product, your video story skills will never improve. 

As simple as it gets
A company called Pure Digital has released a new line of video cameras that make
shooting basic video as easy as recording a conversation on an old microcassette
recorder. The device is small and basically “idiot-proof” since it only has buttons 
for play, record, stop, forward and back. It has to be hand-held and doesn’t zoom,
so it’s only appropriate for basic
videography, like shooting the 
subject of a story so the audience
can see and hear the person talk
and sense their personality. 

The Tri-City Herald in Washington
state purchased one of the cameras
in January 2007 and deployed it

Chapter  9: Shooting Video for  News and Feature Stories

98
J o u r n a l i s m  2 . 0 : How  to  S u r v i ve  a nd  T h r i v e

Pure Digital video camera.

The gridlines show you how to compose video 
using the “rule of thirds.”
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within a couple hours. A reporter shot a video interview and published it on the
site the same day. Web site director Andy Perdue had this to say about the trial:

“Was this video compelling? Not particularly, but it wasn't bad. It provided a voice
and face to the story, and it offered a multimedia element. It was no worse than
what most local TV news stations offer at 6 and 11 p.m. Perhaps of greatest signifi-
cance, our newsroom embraced this technology in record time: 2.5 hours!”

The version of the Pure Digital camera that holds 30 minutes of video sells for
$129 at national retailers like Target and Best Buy (as of January 2007). There is
also a 60-minute version for $179. 

“We plan to purchase one or two of these per month throughout the year and
deploy them in our bureaus as well as in the newsroom,” Perdue said.

Do a trial run
If you are interested in learning to shoot video, get comfortable before heading
out on assignment. Shoot some footage at home of your family or friends and
experiment with different types of shots. Practice capturing a mix of shots, using
different types of microphones, using a tripod and lighting. Shooting basic video
is not difficult but, like most new technology, takes some getting used to. 

Assignment:
1. Watch your favorite local TV news station.
2. Try to mimic shots you find effective.
3. Compare news stations.
4. Look for the rule of thirds.
5. Be a critic; it will help you improve.

1 David Leeson, "Preserving our Vision," Sports Shooter, November 16, 2006. David Leeson is a staff
photographer for The Dallas Morning News who has covered conflicts and wars all over the globe. In
2000 he began shooting video for The Dallas Morning News, becoming one of the first photographers
shooting video for a newspaper on a full-time basis.



Chapter 10:

Basic Video Editing

You can use readily available and cheap software to edit video into nonlinear

stories or to highlight clips that support your stories.

Introduction
Now that you’ve captured great video on your camera (or cell phone), it’s time to
prepare it for others to see. While many of the digital skills you will learn in this
book are “platform agnostic” — meaning they look the same no matter what type
of computer you are using — editing video will be different for those using Mac
computers versus those using a Windows machine. 

We will detail the basic editing process mostly using iMovie for the Mac and
Windows Movie Maker for the PC. Why? Because both are free, and one is probably
already installed on your machine. And both are easy to use and accomplish the
basic tasks you need. 

The magic of digital video is the simplicity with which you can rearrange the
order of your clips. It’s unlikely you’ll want to create a video story that plays the
footage in the exact same order that you filmed it, so editing and arranging the
clips will allow you to present the story just the way you want. 

In addition to deciding on the sequence of your clips, you’ll need to decide
whether you want to add such things as music or narration to tell your story.

Good audio will make all the difference to your video, but you’re not relegated
only to the audio that is on the videotape. iMovie and Movie Maker make it easy
to import music files or voice-overs and place them exactly where they’ll have the
most impact on your video.

Voice-overs can be especially helpful for video footage with lots of noise. Think of
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a high school basketball game where a game-winning shot sends the crowd into a
frenzy. A voice-over can explain who made the shot and tell you the final score.
The frenzied crowd can still be heard, but the level has been lowered so as not to
interfere with the narrated information.

Both iMovie and Movie
Maker will also give you
various options for transi-
tions, which allow you to
control how one clip
evolves into another.
Without transitions (such as
fading into/out of a shot),
each clip will have a hard
cut and that is fine, and
even desirable, for news stories on video. Avoid overly fancy transitions, which
can make your story look amateurish and silly. Leave those features for the home
movies.

You may also want to add titles so you can identify speakers in your video or 
publish credits at the end of the clip. You can use the Titles feature for this but
resist the urge to import a title into the beginning of your video. That’s also a 
little too “home movie” for news.

Remember, earlier we discussed the option of shooting a still photo with your 
digital camera so that you would have a thumbnail image that could be used to
promote your story. With both iMovie and Movie Maker, you can capture a “screen-
shot” or a mug that can be used in print to tease to the online video package or
on the Web site as a promotional icon. 

NOTE: With all computer production, it is important to save often so you don’t
lose your hard work should you make a mistake. 

Once you’ve produced your video package you’ll be ready to put it online, but first
it must be compressed. Talk to your Web staff, if you have one, about their pre-
ferred format for video on the Web site. They may have a system in place to
process video and serve it in Flash, which allows for greater quality and smaller
file sizes. If that’s the case, you can export your file with a much larger file size. 

You’ll likely also need someone from the Web site to actually publish the video on
the site with File Transfer Protocol or they will give you the directions to do it
yourself. (See Chapter 1.)

Voice-overs can be 
especially helpful for 
video footage with 
lots of noise.
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Mac users: iMovie (PC users, skip to page 108.)
iMovie is a simple yet powerful video-editing program. Here is a diagram of the
interface layout. 

Once you launch the program, the next step will be to import the video from the
camera into the software operation. Here’s how:

1. Use a FireWire cable to connect
your video camera to the FireWire
port on your Mac, then turn on
your camera by moving the
switch to playback mode instead
of camera mode. 

2. Create a new project by clicking 
the Create Project button or by
going to the File menu and then
choosing New Project.

3. In the window that appears, type a name for your project. Notice that
iMovie automatically saves your project in the Movies folder on your hard
drive. 
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4. Use the playback controls in iMovie to rewind to where you want to start
importing.

5. Click the Import button.

6. Watch as short pieces of your video footage, called clips, appear in the
iMovie Shelf.

7. When you’re finished importing, save your project by opening the File
menu and choosing Save Project.

Arranging your clips

Your goal is to edit your clips in the order that will best tell your story. At this
point, the Shelf should be full of clips and the Viewer should be empty. To fill
the Viewer pane — which holds the movie you are creating — first find the best
footage by viewing each of the clips and then dragging the ones with footage you
want to use into the Viewer pane. 

NOTE: This will move the clip from the Shelf to the Viewer, and you will no longer
have a copy of the original clip on the Shelf. So if you make changes to the clip
in the Viewer and delete some portions, then change your mind and decide you
want to include some of the parts already deleted, you will have to re-capture it
from the camera. So it’s a good idea to copy the clips from Shelf to Viewer, there-
by leaving an original version in the Shelf in case you need it. This is done easily
on the Mac by holding down the Option key while dragging the clip from Shelf to
Viewer.

Once you have dragged the best clips to the Viewer, arrange them in the order
you want by clicking and dragging. You can change your mind later, but it’s best
to have a good idea of how the movie will go before you begin editing down the
footage. 

Just keep the good stuff

While the filming of a video is important, it’s the editing that will make or break
it. So be very choosy when deciding which footage to keep and which footage to
delete. Here’s how to delete selected footage from a clip:

1. Click the Timeline Viewer button in the iMovie window. This will show the
clip’s length in minutes and seconds.



2. Select a clip from the iMovie timeline by clicking on it. It will turn blue. 
A blue scrubber bar appears just below the Monitor area where the clip is
displayed. On the top of the scrubber bar is a small gray inverted triangle,
marking the point in the clip that corresponds to the picture in the Viewer.
This triangle is called the playhead.

Move your mouse over the scrubber bar and two tiny triangles appear on the far
left that are called crop markers. These are what you use to crop your video. 

3. Click on the right crop marker triangle and drag it to the point where you
want the clip to stop. The playhead also will move to that point in your
timeline. 

4. Click on the left crop marker triangle and drag it to the point where you
want your clip to start. Again the playhead will move to that point. 

NOTE: The color of the scrubber bar changes from blue to yellow as you drag. You
can either delete the yellow area or keep the yellow area, depending on which
command you use next. 

5. If you want to keep the yellow area, select Edit -> Crop or use the key-
board shortcut Apple -> K. The blue parts of your clip on either end will
be deleted and will disappear.

6. If you want to delete the yellow area, select Edit -> Clear. The blue 
parts on either end will merge together to make a continuous clip and the
yellow area will be deleted.

NOTE: This is why it’s a good idea to copy the clip from the Shelf into the Viewer,
so you’ll still have the original footage in case you change your mind or acciden-
tally delete too much. It you want to undo an edit, simply select Edit -> Undo or
use the keyboard shortcut Apple -> Z.

Now move on to the next clip and repeat the steps, eliminating the excess
footage and keeping just the best parts. iMovie will make the clips play continu-
ously as if nothing was cut.
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Working with audio

You can adjust the volume of your audio or
add music or narration to your video. Here’s
how with iMovie. 

To adjust audio levels: Although this may
be too advanced for most beginners, iMovie
allows you to change the volume on the
audio for the entire clip or any section you
want to be louder or quieter. To experi-
ment, go to the View menu and then select
Show Clip Volume Levels.

The thin purple line in the middle of the
clip is what you edit. Click and drag the
line higher if you want the audio in that
part of the clip to be louder, or drag the
line lower if you want it quieter. 

Using narration: You can record a voice-
over quite easily using your Mac. First,
write out the script and practice reading it
a few times. (See Chapter 11 for more tips.)
Then click the Media tab on the iMovie
interface and, when you’re ready to record,
click the red circle button next to the word
Microphone.

Read the script into the built-in mike on
the computer or, if possible, use an exter-
nal mike. This is recommended, but many
computers don’t have a place to plug in a
mike. If yours does, it will either be in the
back near the speakers/headphones jack or,
if it’s a laptop, on the side or back. 

Import your narration into iMovie with the
same process described earlier. 

To import audio: iMovie can easily add a
music file to video, as long as it’s an MP3

Royalty-free music

Be careful when adding music or
other audio to your project as most
music features restrictive copy-
rights based on a royalty payment
system. In order to use that
Radiohead track for background on
your video story, you would need
permission from the band’s record-
ing company and must pay a royal-
ty every time the music was heard
by a reader/viewer.

So look for royalty-free music,
which allows you to pay one low
price for a piece of music and
receive the right to have it played
with your project as many times as
needed without additional cost.

Apple’s GarageBand software
(www.apple.com/ilife/garageband)
makes incorporating audio easy
and comes with 200 sound effects
and 100 jingles that are royalty
free. You can also purchase Garage-
Band Jam Packs that feature
dozens more tracks separated into
musical genres such as world
music, symphony orchestra and
“rhythm section.” 

The audio channel on the Creative
Commons Web site (creativecom-
mons.org/audio) features links to
artists and resources with royalty-
free — and sometimes totally free
— music available. You can also
search for royalty-free music on
the Internet and find Web sites
that sell a dizzying array of studio
music with affordable, royalty-free
prices. 



and is already imported into your iTunes program. Just click on the Media button
and select the track you want. 

NOTE: Be aware that, unless you have rights to commercial music, you can’t use it
in your video. GarageBand, Apple’s music program, which should also be installed
on your Mac, features many royalty-free music tracks that can be used as lead-in
or lead-out background music.

Adding transitions

Most news videos use very few transitions, such as fading into/out of a shot, to
control how one clip evolves into another. However, a few of the basic transitions
might come in handy, and you can test how a transition will look in your video.
Select a clip that you want the transition to start from and click on the Editing
tab, then click Transitions. A menu of available transitions will replace the win-
dow where the Shelf was. Select a transition and a preview of it will play so you
can see how it will look. 

To add it to your video, simply drag it from the menu area into the timeline
between the two clips you want to be transitioned. If you reconsider later, simply
select the transition in the timeline and hit Delete.

Adding titles

It’s often necessary to identify speakers in your video, or you may need to publish
credits at the end. Use the Titles feature to do this. To add a title:

• Select the clip where you want to add the title.

• Click the Editing tab, then click Title and a menu of title styles will appear
where the Shelf was. Select the title that you want and enter the textual infor-
mation into the box. A preview of the title will appear in the viewer. 

• Modify the font style and size with drop-down menus. 

• Modify the effects using the pre-set options but, again, keep it simple and
professional (no flying words). 

• Modify the color of the text by clicking the box next to the word Color and
making a selection from the palate. 

• Opt for your title to appear on a black background, rather than superimposed
over the video, by clicking on the small box next to the words Over Black.

• Check the small box next to QT Margin, since you will eventually export your
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video as a QuickTime movie, and this will make the title fit in the margins of
the QuickTime movie.

• Optional: You can adjust the speed or duration of the title by dragging the
blue button in the sliding Speed bar near the top. Drag to the left to shorten
the time your title will appear on a clip or to the right to increase the dura-
tion of the title.

Now add the title to your video by dragging it to the timeline just before the clip
where you want the title to display. 

To delete a title, click on the clip that contains the title and in the menu at the top
select Edit -> Clear. That will delete the title but won't affect the rest of the video.

Using still photos

At some point, you may find that your subject has photos that would help tell the
story, or a photographer has shot some stills that you want to use in your video.
No problem. Simply add the photos into the iPhoto Library on the machine you’re
using to make the movie, then click Photo from the special menu below the Shelf
area. (Note: The photo must be in JPG format. See Chapter 8.) 

Find a thumbnail for the photo in the menu and select it. Before adding it to 
your video, adjust the time the photo will be displayed with the slider bar in the
Viewer menu. You can also use the zoom tool for a closer look at the photo, or
click the box next to Ken Burns effect to make the photo “pan and scan” during
the movie. (You can control how much “pan and scan” will occur with the Start
and Finish controls.) 

When you have the photo set the way you want, drag it to the timeline and place
it where you want, just like you did with video clips.

Grabbing screenshots

To capture a still image that can be used to promote your video package, find a
spot in the video that would lend itself to a small, iconic image by moving the
playhead to that location. Then under the File menu at the top of the screen,
select Save Frame As …

Choose JPG from the Format menu and navigate to your Desktop folder (or one
that you’ll remember) and click Save.



Exporting video for the Web

By default, video files are too large to publish online without compressing, even
with the proliferation of broadband connections. So the final step in producing
your video story will be exporting it for online publication.

Save your project one more time to be sure you have all the changes. The export
process will produce a compressed copy of your file but it will not alter the original.

Since you’re using iMovie, the export format of choice will be QuickTime. Under
the Share menu on the top of the screen, choose QuickTime. You will be presented
with a drop-down menu with several options. Web or Web streaming are probably
your best bets, although compressing and exporting video files for the Web can be
more art than science. 

Read the fine print as you toggle between selections and note the approximate
file size. This is the information you’ll use to make your decision. As a general
rule of thumb, the file size should be no more than 1MB for each minute in
length, meaning a three-minute video should be less than 3MB. 

If you are running your own site, it’s probably best to select one file format to
use for all of your downloadable videos. If you are part of a news organization,
talk to your Web staff about their preferred format for video on the Web site. 

For PC users: Windows Movie Maker
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Like iMovie, Windows Movie Maker is a simple yet powerful video-editing program.
The interface has four main areas: The Tasks pane, the Collections, the Preview
Monitor and the Timeline. A diagram of the interface layout is on the previous page. 

Once you launch the program, the next step will be to import the video from the
camera into the software operation. Here’s how:

1. Use a USB cable to connect your video camera to the USB port on your
computer, then turn on your camera by moving the switch to playback
mode instead of camera mode.

2. Click “Capture video from camera” link in the Tasks pane. (See example
on opposite page.) If you don’t see the link, expand the menu under the 
1. Capture Video label. The software will automatically recognize the 
camera through the USB connection and begin importing the video. 

3. The clips appear in the Collections pane.

4. Once the import is finished, save your project. Select File -> Save from
the menu at the top and type a name for your project. Notice that Movie
Maker automatically saves your project in the My Movies folder under My
Documents on your computer. You can modify this if you’re so inclined.

Arranging your clips

Again, you’ll want to arrange your clips in the order that will best tell the story.
At this point, the Collections should be full of clips and the Timeline should be
empty. To fill the Timeline pane — which holds the movie you are creating —
first find the best footage by viewing each of the clips and then drag the ones
with footage you want into the Timeline pane. 

Once you have dragged the best clips to the Timeline, arrange them in the order
you want by clicking and dragging. You can change your mind later, but it’s best
to have a good idea of how the movie will go before you begin editing down the
footage. 

Just keep the good stuff

While the filming of a video is important, it’s the editing that will make or break
it. So be very choosy when deciding which footage to keep and which footage to
delete. Here’s how to delete selected footage from a clip:

1. Click the Show Timeline button in the Timeline window. This will show
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the clip’s length in minutes and seconds. (Note: the button you just
clicked now reads Show Storyboard and you can return to the previous
view by clicking it again.)

2. Select a clip from the Timeline by clicking on it. 

3. Find the spot on the video where you want to trim an end off, then 
under the Clip menu, select Set Start Trim Point or Set End Trim Point,
depending on whether you want to chop the front of the clip or the end.

Note: You can also hover your mouse on the end of the clip that you 
want to trim. The selection pointer will become a red icon with two 
arrows. Click and drag the red arrow over the area you want to delete.

4. If you want to delete a portion of the middle of a clip, you first need to 
split the clip so the part you want to delete is on one end. Do this by 
moving the playhead to the beginning or end of the portion you want 
to delete, then under the Clip menu, select Split. Now you can repeat 
Step 3 to remove the footage. 

Working with audio

As with iMovie, Movie Maker makes it easy to import music files or voice-overs
and place them exactly where they’ll have the most impact on your video.

Using narration: You can record a voice-over quite easily if your computer has a
microphone input (and you have a mike). If not, you can use the video camera.
With the lens cap on the video camera, turn the camera on and begin recording. 

In either case, it’s a good idea to first write out the script and practice reading it
a few times. (See Chapter 11 for more tips.) Read the script into the built-in
mike on the camera or use an external mike. 

Narration with a built-in mike: If you have a desktop computer, the input port
for the mike is likely on the back of the machine (real convenient, huh?). If you
have a laptop, it likely will be on the side. Once the mike is plugged in:

1. Click the Tools menu in Movie Maker, and then click Narrate Timeline.

2. Under Narrate Timeline click Start Narration.

3. Speak normally into your microphone, and adjust the Input level so that
the bar is about 70 percent up when you are speaking. Speak into your
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microphone as Movie Maker plays your movie. You can narrate your entire
movie at once or just one clip at a time. 

4. When you're done narrating, click Stop Narration.

5. Movie Maker will save your narration as a separate file. In the Save Windows
Media File dialog box, type a name for your narration. Then click Save.

6. Click Play in the Preview Monitor to watch your movie and listen to the
narration.

7. If the narration is too loud or too soft in comparison to the movie, right-
click the narration on your timeline and then click Volume.

8. In the Audio Clip Volume dialog box, move the slider to the left to make
the narration quieter or move it to the right to make it louder. Then click
OK.

If the timing is off or you stumble and mumble through one part or another, you
should re-record it. To delete narration so that you can do it over, right-click the
narration on the Timeline and then click Delete. 

To import audio: If it’s easier to record narration with a different device, such as
a portable digital recorder, you can import the audio and combine it with your
video. Edit the audio clip so it has just what you want — you can do some trim-
ming in Movie Maker, but it’s better to do the bulk of the editing in a separate
program. (See Chapter 8 for more information.) Once you have what you want,
follow these steps:

1. Under the Capture Video menu on the left, click Import audio or music.

2. Choose the file on your computer from the file browser. Almost all audio
file formats are allowed, but MP3 is still preferred. Make sure the Create
clips for video files option is checked.

3. Find the audio file in the Collections win-
dow. Click and drag it to your timeline, plac-
ing it under the section of the video where
you want it to go.

4. The clip will land on the line below the
video marked Audio/Music. You can move it
forward and backward by clicking and drag-
ging it (when you hover your cursor over the

NOTE: Be aware that
unless you have rights
to commercial music,
you can’t use it in
your video. (See
Royalty-Free Music,
page 105, sidebar.)



clip it turns into a
hand icon).

5. To trim the ends,
click on the small
triangle on either
the beginning or the
end and drag the
end into the clip. 

Adding transitions

Most news videos use very
few transitions to control
how one clip evolves into
another. However, a few of the basic transitions might be useful.

1. Under the Edit Movie menu on the left, select View video transitions and
notice that the Collections menu is now filled with blue shapes with
names like “Bars” and “Circles.” (See diagram.)

2. Select a transition to preview, then click Play in the Viewer to see what it
looks like. 

3. Once you find the one you want, find the place in the video where it should
go. Then drag the transition down to the Timeline to the correct location.

If you reconsider later, simply select the transition in the Timeline and hit Delete.

Adding titles

It’s often necessary to identify speakers in your video, or you may need to publish
credits at the end. Use the Titles feature to do this. To add a title:

1. Select Make titles or credits from the Edit Movie menu on the left. 

2. Choose from the five options presented on the next screen, ranging from
“title on the selected” to “credits at the end.” Note: If you didn’t move
the playhead to the location in the video where you want the text to go,
you can move it now.

3. Enter the textual information for the main title into the top box and sub-
head information into the bottom box (if desired). Movie Maker has
dozens of text options, but very few work for a news video and the best
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one only works with a one-line title. So if you need a name and title, enter
it on one line like “John Doe, President, XYZ Co.”

4. Click Change the title animation and select Subtitle from the menu.

5. Next, click Change the text font and color and modify the size, font,
color, position and transparency of the text. Again, since this is a news
video, keep it simple and professional.

6. Click Done, add title to movie.

To delete a title, click on the title as it appears in the Title Overlay line of the
Timeline view and hit Delete. That will delete the title but won't affect the rest
of the video. 

Using still photos

At some point, you may want to use still photos from your subject or shots from
your photographer in your video. No problem. Simply add the photos to the com-
puter you’re using for video editing, then click Import pictures from the Capture
video menu on the left. (See Chapter 8 for information on handling digital photos.)

Find the photo in the file browser menu and select it. Make sure the Create clips
for video files option is checked. If it is, the photo will appear in the
Collections area and you will be able to drag it into the Timeline from there,
placing it exactly where you want it in your movie. By default, the program will
set your picture to show for five seconds. If you want to add or subtract time to
the picture, click on the arrow on the side of the picture and drag it to the right
(for more time) or left (for less).

Grabbing screenshots

If you need a
“screenshot” or a
mug to promote your
video in print or
online, you can easily
capture one. Find a
spot in the video
that would lend
itself to a small,
iconic image by



moving the playhead to that location. Then under the Tools menu at the top of
the screen, select Take Picture from Preview. A file browser will appear, allowing
you to select the location on your computer where the thumbnail image will be
saved. (The Desktop is a handy location for temporary files like this.) Then click
Save.

Exporting video for the Web

By default, video files are too large to publish online without compressing so the
final step in producing your video story will be exporting it for online publication.
Save your project one more time to be sure you have all the changes. The export
process will produce a compressed copy of your file but it will not alter the original. 
Since you’re using Windows Movie Maker, the export format of choice will be
Windows Media. Under the Finish Movie menu on the left of the screen, choose
Save to my computer. A pop-up window will present a “wizard,” which will step
you through the rest of the process. Here are the selections to make: 

1. Enter a name for your movie.
2. Choose a location on your computer where you want to save the file.
3. Click Show more choices on the next screen (titled Movie Setting).
4. Select Best fit to file size and enter a maximum size in Megabytes (MB).

A good rule of thumb is 1MB for each minute of length in the movie, 
so a three-minute movie should be no larger than 3MB. 

5. Click Next and the software will export your movie to the location 
you specified.

Assignment:
1. Think of a short story you would like to tell with a video. It could be a 

Little League game or other youth activity, a weekend trip or, if you want 
to do something “newsy,” a press conference or a public meeting.

2. Think of about three to six clips of video that would tell the story, mixing
wide, medium and close-up shots. Then shoot the clips with a camera.

3. Capture the video into a computer that is equipped with iMovie or 
Windows Movie Maker and save it to the hard drive.

4. Edit the clips together to make a movie. Add voice-over narration, music 
and transitions. 

5. Then output the video for display on a Web page.
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Chapter  11: Writ ing Scripts,  Doing Voice-overs

Chapter 11:

Writing Scripts, 
Doing Voice-overs

The idea of recording audio voice-overs or conducting video stand-ups causes

immediate angst for most print journalists. Learn some tricks of the trade to

feel normal “on the air.”

Introduction
“Are you ready?”

“Sure. I’ll just wing it.”

There is a tendency to think that, because anyone can speak, improvisation is
good enough when it comes to adding voice to a multimedia project. 

It’s not. 

Whether you are interviewing a subject “on tape” or providing voice-over 
narration for video, preparation will make the difference between producing 
professional-level projects or “amateur hour.”

Can you imagine “just winging it” when it comes to writing a news story or
shooting an event as a photojournalist? I sure hope not.

Invest a little more time in your multimedia project with planning and preparation
for your voice contribution and you’ll make the rest of the effort worthwhile. For
example, taking just a moment to decide where to record an audio interview can
help you avoid ending up in a noisy coffee shop with too much background noise.
Following are some easy-to-follow directions on how to get “ready for prime time.”



Interviewing while recording
Recording an interview digitally provides content that can be used in many 
different types of multimedia:

• As a stand-alone audio file with a news story (especially powerful if the 
subject matter is emotional or the subject is well-known).

• As a podcast.

• As a stand-alone audio file for a blog post.

• As the audio to accompany a photo slideshow (works best when mixed with
natural sound).

Location, location, location: Ideally, you will be able to record the interview
face-to-face. If possible, pick a location for the interview that is quiet and has
good acoustics. A person’s home or office is a good option; a coffee shop or
restaurant is not. If the interview needs to occur outside, make sure it is as far
away from traffic and crowds of people as possible. 

While it’s possible to record a phone interview, the lower sound quality makes 
it hard to listen to phone recordings for long periods of time. Try to keep the
interview focused and edit it down to just the most salient points. (Or consider
re-asking some key questions at the end. More on this to come.)

Pre-interview questions: The subject of the interview deserves to know a few
things before they start answering your questions on tape. Provide them with
some advance information, such as:

• How long will the interview be?

• How much editing will be done to the audio (if any)? If you can go back and
take out the long pauses and the ums and ahs, it will help the subject relax
and not feel like they’re “on the air” and have to fill every second. 

• How will the audio be used and who is the audience?

• Will you send them a few questions you want them to answer so they can
articulate their thoughts more succinctly?

It’s a good idea to have several questions pre-written. While you may have years
of interviewing experience, this is a different kind of interview where you also
have to think about the equipment (is the subject speaking loud enough?), the
environment (is that air conditioner too loud?) and the pacing of questions and
the banter so it sounds good later. That said, don’t script every question because
the natural ebb and flow of conversation is an important quality that will make
listening to an audio interview easier for the audience.
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What you say can — and will — end up on tape: Some of the most common
interviewing tricks that journalists use don’t work well when conducting an audio
interview. 

For instance, you have probably learned to rely on “uh-huh” and “I see” and
“really?” to let the person you’re interviewing know you’re listening and under-
standing what they’re telling you. In an audio interview, try to use nonverbal
clues like nodding instead. You may have developed a habit of audibly agreeing
with what your subject is saying while they are saying it. When the tape isn’t
rolling, this works to let the subject know you want them to elaborate upon this
area, but when the tape is rolling, these interruptions can be disturbing to the
listener and can cover up some of the subject’s key points. So remember, while
the subject is talking, remain silent.

You may have also honed a knack for establishing a rapport with your subject by
showing how much you know about their topic. Again, this is effective early in
the relationship but try to develop your rapport before recording the interview
digitally. Listeners want to hear what your subject has to say, not what you think
about the topic. So remember your job is to ask questions. Some context follow-
ing a subject’s response, like spelling out an acronym, is helpful. But try to keep
it to a minimum.

One good option is to capture “sound bites” at the end: If the goal of record-
ing is to produce an audio clip to accompany a news story, consider waiting until
the end of the interview to do the recording. That way you can conduct the inter-
view just as you normally would, then ask the subject to address a couple of the
most salient points for the recording. 

This helps you during the interview and helps speed the editing and processing of
the audio back in the office. Instead of going over an hour of tape to find a few
minutes worthy of publishing online, there will only be a few minutes to edit. And
by letting the interview play out “normally” you will know which questions you’d like
your subject to address for recording (something you may not know in advance).

Mark the best spots: Another technique to speed up the editing process when
recording the entire interview is to mark the points where the interviewee says
the best stuff. Most journalists take note when they hear a quote or a nugget of
information that will be especially useful. When that happens while recording,
write down the counter number on your tape recorder or the time elapsed from a
digital recorder. You’ll save loads of time whether you’re producing audio for the
Web or just need to get to the best quotes to write your story.



Voice-overs 
You cannot control everything that happens when interviewing someone else, but
you can have complete control of a voice-over or the narration that you will
record for a video story or an audio slideshow that goes with a photo gallery.
Here’s how to make the best of it. 

Write a script: Having a detailed script that you can practice a few times before
turning on the microphone will greatly enhance the quality of the finished prod-
uct. Crafting an effective script is quite different from news writing. The fewer
words the better as the purpose of voice-over narration is to amplify or clarify
what may be obvious on screen. Short, simple declarative sentences work best. 

Choose words that are easy to say and have a good flow when put together. Build
in natural breaks for taking a breath. Add some verbal “white space” so the narra-
tion doesn’t overpower the visual elements of the story.

Warm up: While it may feel weird,
stretching the muscles in your face and
mouth and humming or singing will help
prepare you to be recorded. Open your
mouth as wide as possible and move your
jaw back and forth. Then hum some deep
notes and some high notes and sing a
few bars of a familiar song, like “The
Star-Spangled Banner.” Your facial mus-
cles and vocal chords need to be ready to
perform, just as if you were about to go
running or play basketball. 

Operative words: Marilyn Pittman
(http://marilynpittman.com), who serves
as a guest lecturer at UC Berkeley’s
Graduate School of Journalism, teaches
print journalists about audio and video
performance. She recommends finding the
“operative” words in your script — the
words that are essential to telling the
story — before you begin recording. 

Which are the operative words? The words
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Script for Hurricane Family Feature
(courtesy KPLU radio):

(Kitchen nats — opening drawer)  :03

Patricia Quinn searches
through the kitchen cupboards
of her new home in Seattle.    

(Kitchen nats — raw sound) :02

Behind freshly-painted 
cabinet doors, are small
reminders of her family’s 
old life in New Orleans.    

(Kitchen nats — bag rustling)

She pulls out a prized posses-
sion — authentic Louisiana-
style beans.   

(Kitchen nats — beans and season 

salt mixed) :19

NOTE: See Appendix, page 125, 
for the full version of this script.
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that would give the listener or viewer the gist of the story rather than the com-
plete sentences in the script, Pittman says. Usually they are the classic who-what-
where-when-why-how words — nouns, adjectives, adverbs, titles, names.

Now read through the script and add emphasis to the operative words. According
to Pittman, you can do that in four ways:

• Volume — Increase or decrease the volume of your voice when saying an
operative word. Emphasizing a word by making your voice louder is also called
"punching" it. 

• Pitch — Change the pitch of your voice when you say an operative word,
going up or down the scale, high and low, falsetto to baritone.

• Rhythm — Change the rhythm of your voice — the space between the words
— when saying an operative word. Pause before the word, after the word, or
both to emphasize it. A pause is especially effective before a word that's com-
plex or highly technical in nature. A pause is also effective when you're intro-
ducing a new idea in a script. 

• Tempo — Change the tempo or speed of your delivery to emphasize an opera-
tive word. You might pick up the tempo where the copy is less important, and
then slow down when you hit a section with more operative words to empha-
size them. Or you might stretch out a vowel in an operative word. 

Be conversational: While focusing on operative words will help, don’t allow your-
self to be too distracted by them. It’s more important to be natural and conversa-
tional as you speak. If it sounds like you’re reading a script and intentionally
emphasizing some words but not others, the entire project will suffer. So aim for
a flowing, conversational reading of your script first, and then add the more com-
plicated techniques of operative words.

On-camera standup
The on-camera standup, an evening news staple, is not something many print
journalists look forward to. Occasionally, however, it may be necessary, especially
when covering breaking news or a major sporting event. For best results, do some
planning and remember the following tips. 

Content: Keep it short, of course, but try to provide something extra for the audi-
ence. Instead of saying there was an accident on I-10 and the trucker was hauling
chickens, you might add that they were running all over the highway and that the
officers at the scene were bent over laughing. Print reporters often want to keep



the good details for their written story, but shouldn’t.

Write a script and warm-up: Even if you are reporting on location from a break-
ing news event, there are always a few minutes to run through a rehearsal before
the tape rolls. If there isn’t time to write a script, at least jot down an outline
with the major points that you need to cover. 

Be stable, breathe easy: Posture is important, so be sure you’re standing up or
sitting as straight as possible and that your chin is parallel to the floor. Relax
your shoulders but try not to move them too much while talking. Breathe from
your stomach and diaphragm, not your chest. 

Talk with your hands: The most successful on-camera personalities exude person-
ality and appear conversational. Using hand gestures is an easy way to add some
informality and will help you feel a little more “normal” during the recording.

Find the right location: Ideally, you will find a spot that is not too busy, or loud
or poorly lit. If you are going out in public, look for a setting that contributes to
the story by adding an “environmental” element. But remember to ask for permis-
sion to tape if that spot is on private property. 

Whether you are “on location” or in your office building, think sound and lighting
first. If the on-camera subject will be wearing a wireless mike, you can get away
with some environmental noise (but not a lot). If you have some heavy duty
lighting equipment, you can shoot anywhere indoors and even compensate for
indirect sunlight outdoors. If you don’t have good external lights, make sure you
pick a location that fully lights the subject. You don’t want any backlighting or
shadows on the subject’s face.

Assignment:
1. Practice interviewing someone you know with a recorder (tape or digital).

Write some pre-interview questions first, then review the interview and 
listen to how well you manage the flow of the conversation and listen for
things you wish you would or wouldn’t have done.

2. Find a video news report online. Watch it while paying close attention to
when the narrator speaks and what the narrator says. How could you make
it better? Write out a new script and practice reading it into a recorder.
Then play it back with the video playing without sound and see how well
you did.
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Putting it All Together 

It’s all in your head.

The ability to “think online” is the most important skill a journalist can acquire or
develop today. The previous 11 chapters detail several skills that are important for
a journalist to function online, but it is the mindset that will imagine the digital
possibilities of a story or a project. If you can’t develop a digital mindset, all the
digital training in the world won’t help. 

This was the highlight of a study released in October 2006. The independent study
by C. Max Magee, as part of his master’s degree program at Northwestern Univer-
sity’s Medill School of Journalism, sur-
veyed 239 professionals working in
online journalism and 199 people who
are observing its evolution. Its goal:
To define the skills and intangible
characteristics that are most impor-
tant in online newsrooms.

Online journalists agreed that what
makes online journalism different isn’t
so much the technical skills as it is a
way of thinking. 

A willingness to learn new things, to
multitask and to work in teams were
especially appreciated, in addition to
other skills that most working journalists already know such as attention to detail
and ability to work under time pressure.

“The crucial obstacle is the mental one we impose on ourselves in sticking with
the belief that our job is to print ink on paper and deliver it with the help of
small boys in shorts before 7 a.m.,” Ulrik Haagerup wrote in the December 2006

Epilogue

The problem is
that everybody
wants progress 
but nobody wants
change.
– Ulrik Haagerup, editor in chief of
Nordjyske Media, Aalborg, Denmark



Nieman Reports. “This change can be a hard one for journalists to make; it means
realizing our task is to serve people in our community by telling them useful and
entertaining stories through whatever technology they want to use.”

Journalists are smart people. Many have already learned how the Web and digital
technologies allow for nonlinear storytelling. They have learned the power of
database reporting and new styles of writing thanks to blogs. They understand —
even appreciate — a new world order where journalists and editors are no longer
preaching to the readers/users/viewers. No longer a lecture, news is, indeed, a
conversation, vibrant in its many facets, directions, layers and continuum.  

Hopefully, you feel like the curtain has been pulled back on the wizard (to some
degree). The digital way isn’t for propeller heads only. Anyone who can use the
Web and e-mail has the skills necessary to begin blogging or building multimedia
projects. Now, all you need is to open your mind to the possibilities and dip your
toe into the water. 

Scratch that. It’s time to jump in. 

Making time: Just as digital skills are beginning to identify job candidates for
newspaper job openings, the lack of digital skills will identify those who are
expendable. And with more than 3,000 newsroom job cuts just since 2000, 
anyone still working in a newsroom should be looking for ways to become more
valuable to the operation. The same holds true whether the medium is newspaper,
magazine, television or radio.

The two most popular excuses working journalists use when trying to avoid this
new era are: “I don’t know how” and “I don’t have time.” Now that you know
“how” you need to address “when.” Here is one suggestion: Today.

Not tomorrow or next week or the next time something presents itself. Find the
digital skill that interests you the most and start immersing yourself. Whether
that is blogging or podcasting or producing video stories, make a plan to sample
content in that medium and start doing it yourself, if only for practice. Give your-
self a deadline and tell your manager. Then it will become part of your job and
you will find a way to make time for it. 

Remember, scores of working journalists didn’t think they had time for e-mail
when it came along. Some even protested the publication of reporters’ and edi-
tors’ e-mail addresses in fear that they would spend all their time answering inane
reader requests. Today there is no way you could take away e-mail. The digital
skills discussed here are no different.
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Epi logue

Practice for fun: The beautiful thing about digital content is that it’s disposable.
You can practice recording audio or video, setting up spreadsheets or even prac-
tice blogging without cost or publication. At the end of each chapter there are
suggestions on how to get started with each skill or discipline. Find one that’s
interesting and play around with it. That’s right, “play” with it. That’s how most
journalists got into this game in the first place — they enjoyed it (remember
your college newspaper or radio station?). And that’s how most journalists have
adapted to the digital age. They found some fun in learning new skills and creat-
ing content in a new medium. 

Once you begin, look for working examples of the content you’re playing around
with. Once you start blogging — even with a practice blog that no one else can
see — it will give you a different view of existing blogs, especially the better
ones. It’s the same with audio or video. You’ll notice where good editing or use of
natural sound really added to a segment. 

Identifying opportunities: There is a
natural tendency to “swing at the first
pitch” when suddenly armed with new
skills, meaning you try to force a multi-
media element on a current story
because it’s in your focus. It might
work, but it’s more likely that you’ll
need to be patient and wait for the
right opportunity. After all, this stuff
does take time — an ultra-precious
commodity today — and you don’t
want to waste it on a project that doesn’t come out well. 

Talk to your Web folks, your manager or managing editor. Brainstorm about stories
you are currently working on or those that you’ve always wanted to do. Once you
have an idea, fight for the time to do it well. We are past the point of producing
a multimedia project just because we can; we need to be producing multimedia
projects that are professional-looking and high in quality and meaningful to our
audience. And that’s not something that can be rushed, especially for beginners.

Understand, too, that much experimentation has been going on across the news
industry for many years now. Your idea may have been tried somewhere else, only
to fail. Find someone who has been plugged in to the new media movement in
news for some time to help you fine-tune your ideas so you don’t take your
efforts down a previously discovered dead-end road. 

The beautiful
thing about digital
content is that 
it’s disposable.



Fostering community: The easiest way to get involved in the digital age is to
simply start reading the user-generated content on your Web site (if applicable)
and others. Peruse the comments posted on the blogs on your site and others. 
If readers comment on your stories, pick your opportunities to chime in and 
contribute to the discussion. Even something as simple as, “Great comments,
everyone. Keep them coming,” will get you involved in this new paradigm of 
news consumption, which is more like a conversation and less like a lecture. 

If your site doesn’t have blogs or allow comments on stories, ask why not. Start
the conversation. It will force you to think differently and that simple exercise
will help you open up to the possibilities of Journalism 2.0. 

It’s time to learn how to survive and thrive in the digital age. Good luck.
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Script for 
Hurricane Family Feature
Hurricane Family Starts New Life in Seattle

Kendrick/Feature/GA/EH

2-20-06

FOR TUESDAY FEB. 21 M.E. & A.T.C.

*Hosts: May want to play feature in cue before you air it. Music is added to the end
that you may use as a bed to pitch to traffic or rejoin NPR. Fade it on your own.

Nearly six months after Hurricane Katrina, thousands of evacuees are still living in a state
of uncertainty. The federal program that provided hotel vouchers ended earlier this month.
The government plans to terminate all disaster housing assistance March first. Many hurri-
cane victims don’t know what the next day — let alone the next week — will bring. 

That’s not the case for one “family of 17” from New Orleans. They’ve been able to start a
new life in Seattle — thanks to the generosity of strangers. KPLU’s Kirsten Kendrick has
their story.

AV#: 0221KK1 “KPLU News”        4:43 + Music full for 3 minutes

(Anchor note: Cajun music continues up full after my out cue for three minutes. Use as
much as you want for a music bed and fade on your own. The artist is Professor Longhair
— a New Orleans musician.)

Script for Hurricane Family Feature:

(Kitchen nats — opening drawer)  :03

Patricia Quinn searches through the kitchen cupboards of her new home in Seattle.  

(Kitchen nats — raw sound)  :02
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Behind freshly-painted cabinet doors, are small reminders of her family’s old life in New
Orleans.  

(Kitchen nats — bag rustling)

She pulls out a prized possession — authentic Louisiana-style beans.  

(Kitchen nats — beans and season salt mixed) :19 
“And they don’t cook like them other beans. They cream. Glad to have those, huh? Yeah
(laughs). This is a, uh, a season salt that you can put on chicken and fish. If you cook stew
or something like that you can use a little bit of this.” 

(Nats continue then fade under)

Hippocrates said, “Let food be thy medicine, thy medicine shall be thy food.” 

Cooking “true Cajun” is one way Patricia tries to heal the wounds from the hurricane.  

(Nats — pointing out pictures)  (Only underneath voice)

She moves to the living room, and sits on the couch. Her hair is wrapped in a colorful
scarf. She’s cradling a large silver frame in her arms, pointing out photos of her 15 chil-
dren and 9 grandchildren. 

(Nats — pointing out pictures) :07
This is uh, Kiera, that’s Tyrell, little girl who’s down here” … fade under)

The Quinn’s new home in Seattle’s Central District is completely furnished — down to
framed prints hanging on the walls. The house and all the things in it were made possible
through donations. 

Patricia is grateful her family is not in the same situation as thousands of other hurricane
victims — depending solely on government assistance. 

(Patricia — blessing) :11
“I think it’s a blessing … for the house. Some people don’t have a house right now, they’re
putting them out in hotels and things. And I really think it’s a blessing just being here.” 

To get here, she had to leave a city she loves — and the only home her family’s ever
known. But Patricia knew things were going to change the day after the hurricane hit.
Their home was damaged beyond repair, and she could hardly recognize her hometown. 

(Patricia — leaving N.O.) :07
“It was like the third world. It was so sad and pitiful. They had people on the side of the
road walkin’ their way out.”  

The family was sent to a shelter near Houston. But there was no room for them. 

(Patricia — no room in Hou. Shelter) :07
“And I sat down and just started cryin’, you know. I say ‘Lord where’s we goin’ from here?
All of us.’” 

They found an abandoned house. Spending several days sleeping on the floor and scrounging
for food. Then, Patricia got a call on her cell phone from her oldest son, Quincy, in Seattle. 
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His congregation, the True Vine of Holiness Baptist Church, along with other churches, had
raised enough money to fly the entire family to Seattle. 

(Quincy — best cut) :10
“I’m thankful for all the support from all the churches. So that let me know that there are
people that care. And it don’t matter what color you are.” 

Even before the Quinns arrived in Seattle, there was a second wave of generosity. To find
them a place to live. 

(Nats — hammer and saw)

A vacant, run-down house was donated to the family. Church volunteers spent months 
renovating it. 

(Willis — divine makeover) :03
“So we’re calling it a divine makover.”

(Nats — chainsaw + fade)

Ricky Willis is pastor at True Vine of Holiness. He and his wife spearheaded the effort to
bring the Quinns here. It took a lot of work to get the house ready for such a big family. 

(Willis — details work) :07
“Paintin’ these upstairs rooms. Redoing the floors. New electrical, carpet, (fade under) new
windows, weatherproof windows and just a major, uh, makeover.” 

To get it all done, Willis organized work parties of church volunteers. There was fellowship
and, of course, food. Including spicy, gooey barbecue. 

(Nats — sauce and blessing mixed)  :15
“Pastor, what if I just poured it on top of the ribs? That’s fine, that’s great. Bless this food
so it may be nourishment to our bodies as you are nourishment to our souls. In the mighty
name of Jesus, we pray. Amen, Amen.” 

(Nats — people working and talking)

(Nats — saw #2 — fade under)

(Nats — move-in day)

Two months later, Patricia is presented with the keys to her family’s home. 

As she opens the front door, she inhales the scents of new carpet and fresh paint. When
she gets to the kitchen, she stops. All the volunteers who helped make her house a home
… are holding hands in a circle. Patricia stands in the center, fighting back tears. 

(Patricia — thanks pastors) :05
“And I just want to thank ya’ll and I’m grateful for what you all did.”

(Fade under move-in nats)

Patricia’s husband, Lawrence, is still in New Orleans, finishing his last two months on a job
before he can retire. Patricia says the family is adjusting well to Seattle. They like it here.
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But she’s doing what she can to keep their old traditions alive. Especially the food. And
that starts with finding the proper hot sausage for her Gumbo recipe.   

(Patricia — sausage cuts mixed) :15
“The D&D smoked sausage — that’s the special made smoked sausage that they have down
there. It’s the key to it. And you put whatever else you want in it, you know. You holding out
hope that you might be able to get some of that sausage delivered up here or sent up here
or something?  Yeah.”            

(Establish faint Cajun music)

“Let food be thy medicine, thy medicine shall be thy food.” (Pause) Kirsten Kendrick, KPLU
News. (Fade up Cajun music full for two minutes)
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